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Licenses and Permits Module

Overview

The Licenses and Permits module is used to create new applications and licenses, edit

existing licenses, and renew expired licenses.

License and Permits Module Process Diagram

Each object in the flowchart below represents a process in the application.

License Maintenance

The License Maintenance window represents the core of the Licenses and Permits mod-

ule. This window is used to record application and license details, apply appropriate fees,

and track licensing and payment history.

Cash Receipts LP Licensing Window
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The CR LP Licensing window is used to create a license or application based on an LP

License Type template at the time that cash is received for the license.

Adjustments

The LP Adjustments process is used to create adjustments on application or license

records after payments or invoices have been processed. This process also allows you to

apply new credits, deposits, or penalties, reverse transactions, and transfer credits and

payments from one account to another.

Letters

The LP Letters process is used to generate letters that can then be sent out to a filtered

selection of application or license holders. The MS Word-based mail merge form letters

used in this process can be fully customized to meet a variety of mailing needs.

Past Dues

The LP Past Dues process is used to apply the penalties and generate the notifications

associated with LP accounts that have past due balances.
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License Update

The LP License Update process is used to quickly and easily update multiple licenses. This

process can be used, for example, to update licenses after making changes to license-

related fees, or to change the status on a large number of licenses without editing indi-

vidual records.
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LP> Adjustments

Enter Adjustments in LP
Summary

Once invoices and/or payments have been processed, these items can be adjusted in the

Adjustments palette. Follow this process to enter the transaction adjustments.

Step by Step

1     Open or create an adjustments batch. 

l Select the Adjustments palette in LP> Adjustments. This will expand the Adjust-

ments palette and display the steps of the Adjustments batch process.

l Modify an existing batch or create a new Adjustments batch.

l Select a batch number from the drop-down menu at the top of the Adjust-

ments palette to select an existing batch.

l Select New from the Adjustments batch number drop-down menu to create a

new batch. This will open the New Batch window.

l If there are open batches in the Adjustments process, you can create a new

batch without affecting the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current cal-

endar period and are for reference only. The fiscal period of the transactions

in the batch is determined by the Journal Entry Date entered during the Gen-

erate step.

l
Click the Generate icon to populate the Batch Number field with the next

available batch number. Batch numbers are limited to five digits and must be

unique within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number

and clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the Adjustments

palette and press DELETE to delete a batch. Any uncommitted invoices in the batch

will be deleted.

2     Enter or edit the adjustments. 

l Open the Edit Adjustments window (LP> Adjustments> Enter).

l This will display all of the uncommitted adjustments in the open batch.

l
Click the Create icon to open the Create Adjustments window.

3     Create an adjustment. 
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l The Create Adjustments window will determine what type of adjustment you cre-

ate.

l Select an Adjustment Type from the drop-down menu.

l Select Adjustment to make an adjustment to a credit, invoice, payment or pen-

alty associated with an account.

l Select Apply to apply a credit or deposit to an account.

l Select New to create a new invoice or to create a new penalty.

l Select Reversal to reverse a credit, invoice, payment or penalty associated

with an account.

l Select Transfer to transfer a credit, an invoice or a payment from one account

to another.

l Select a Transaction Type from the drop-down menu.

l The options available from this drop-down menu are determined by your

selection in the Adjustment Type field.

l Enter a Transaction Date or select one from the drop-down menu.

l Enter a Due Date or select one from the drop-down menu.

l This field will only be active if New is selected in the Adjustment Type field

and Penalty is selected in the Transaction Type field.

l The Transaction Date and Due Date are used in calculating past due fees in

the LP module.

l The Transaction Date and Due Date are also used in calculating the age of a

transaction on aging reports.

l Enter a Reference Number as an optional method for tracking originating doc-

umentation.
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l Enter a Description for the adjustment. This is an optional field that can be up to 60

alphanumeric characters long.

l Select a license Category from the drop-down menu.

l Enter a License Number for the adjustment or click the field label to select one

from a list.

l The displayed license numbers will be limited to those within the selected cat-

egory.

l Enter an Application Number for the adjustment or click the field label to select

one from a list.

l Select a Target Category for the target license from the drop-down menu.

l The three target fields will only be enabled if Transfer is selected in the Adjust-

ment Type field.

l Enter a Target License Number.

l This is the license that the transfer will transfer the transaction to.

l Enter a Target Application Number.

l This is the application that the transfer will transfer the transaction to.

l Click the Next button.

4     Select the items to adjust. 

l The Create Adjustments window will now display all of the selected Transaction

Types associated with the license.
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l Highlight the transaction you would like to adjust and click the Next button.

5     Enter the adjustment. 

l The Create Adjustments window will now display the transaction information in the

upper Original Details section and the adjusted information in the lower Updated

Details section.

l Depending on the transaction type you are adjusting, different fields will be editable

in the Updated Details section. For example, if you are adjusting an invoice, the

Number of Units and Amount columns will be active for editing.

l Enter the adjustments and click the Finish button.

6     Commit the adjustments batch. 
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LP> Adjustments

Commit an Adjustments batch

Summary

Once you have entered one or more transaction adjustments you will need to commit the

batch. Follow these steps to complete the adjustments batch process.

Step by Step

1     Confirm that adjustments have been entered. 

l Open the Edit Adjustments window (LP> Adjustments> Enter) to confirm that at

least one adjustment has been entered in the batch.

l
Highlight an adjustment and click the Modify icon to change the adjustment

details.

l Click the Create icon to create a new adjustment.

l
Highlight an adjustment and click the Delete icon or press DELETE to delete the

selected adjustment.
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2     Print an adjustments proof list. 

l Open the Adjustments Proof List window (LP> Adjustments> Proof List).

l Select the report type you would like to print.

l The Summary report displays the Invoice Number, Transaction Date, Trans-

action Type, Customer Name, Application Number, License Number, Descrip-

tion and Amount. The total amount for all batch adjustments will also be

displayed.

l The Detail report includes the information displayed in the Summary report

and also displays the Fee Code, Debit Account, Credit Account and debit or

credit amount.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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3     Print the GL Distribution list. 

l Open the Print GL Distribution window (LP> Adjustments> GL Distribution).

l Enter the transaction date you want to appear in the General Ledger for this batch in

the Journal Entry date field. This date will determine the fiscal period in which the

adjustments are recorded.

l The Fiscal Period and Fiscal Year fields will populate based on the Journal

Entry date selected.

l Select a Report Type from the drop-down menu.

l The report will display the Fund, Account, Description, Debit Amount, and

Credit Amount. The report will also provide subtotals by account number and

Fund as well as a report total.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

4     Print the Adjustment Statements. 

l Open the Print Adjustments Statements window (LP> Adjustments> State-

ments).

l Select the Adjustment Types you would like to include in the statement batch. By

default, all types will be checked.

l Use the Printer Adjustment field to adjust where the first line of the statements will

print. If you adjust the alignment of the statements you may want to print a test state-

ment before printing a large batch.

l Zero is the system default. Adjusting the value up will move the first line of the

statement up on the printed page and adjusting the value down will move the

first line down.

l Select how you want the logo to display in the Logo Options field.

l Select All Pages to display the logo on all pages of the statements.

l Select First Page Only if you would like to display the logo on the first page

of a statement only. If the statement is more than one page, the logo will not

display on the second page and the space where the logo normally prints will

be blank, shifting all fields on the second page up.

l Select Don’t Print and Leave Room if you would like to leave the space that

the logo normally prints in on the top of every page, but leave the logo off the
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statements. If the statement is more than one page, the spacing on the

second page will be the same as the first. Choose this option if you are using

pre-printed statement stock with a logo at the top of every page.

l Select Don't Print and Don't Leave Room if you would like to print the state-

ments without logos or blank spaces.

l If more than one statement is being printed, select how the statements are sorted in

the Sort By field. The statements can be sorted by application number, license num-

ber or customer number.

l Check the Print Perforation Line toggle to print a perforation line at the top of the

returnable section of the statement.

l Click the Address 1 field label in the Remit Address section to attach a remit

address to the statement. Remit addresses are created and maintained in the Remit

Address Maintenance window (LP> Maintenance> Remit Address).

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the Adjustment Letters. This is an optional step. 

l The Adjustments Letters are meant to be run in conjunction with the Adjustments

Statements. Rather than providing the financial detail found in the statements, let-

ters provide general information such as the total amount adjusted.

l Select a Form from the drop-down menu.

l The printed letters will use the selected Form as a template.

l Forms are created and maintained on the Forms Maintenance window (LP>

Maintenance> Forms).

l The Tran Date field will populate with the transaction date specified on the

GL Distribution step.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.

l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

COMMIT AN ADJUSTMENTS BATCH 17



l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the adjustments batch. 

l Open the Commit Adjustments window (LP> Adjustments> Commit).

l The Batch, Journal Entry Date, Fiscal Period and Fiscal Year fields will all populate

with the information determined earlier in the batch process. If you would like to

change this information, return to the GL Distribution step.

l Click the Confirm button to commit the batch. The information from the batch is now

permanently posted to the General Ledger and the customer accounts.
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LP> Display> Transaction Detail

Display LP Transaction Details

Summary

The Transaction Detail window is used to display the transaction level details associated

with a filtered list of historical transactions.

Step by Step

1     Open the Transaction Detail window (LP> Display> Transaction Detail).  

2     Filter the displayed transaction details. 

l Enter the desired filter details in the Search Criteria section. Click the Refresh icon

or press ENTER to populate the data grid below with the transactions that meet

the specified criteria.

l Right click on the records in the window and select Export grid contents to

Excel if you would like to export the information that displays in the window to

an MS Excel spreadsheet.

l
Highlight a transaction and click the Display icon to view the transaction details.
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LP> Letters> Generate

Generate LP Letters

Summary

The Letters process is used to generate customized, Microsoft Word-based form letters for

a filtered range of LP accounts. These letters can serve a variety of purposes, such as noti-

fying customers of changes to application rates or requesting updated permit information.

Customers associated with the LP account will only receive a letter if the Notification toggle

is checked on the License Maintenance window (LP> Maintenance> License> General

tab> Notification toggle). Any contacts attached to the license that also have the Noti-
fication toggle checked will receive a letter as well (LP> Maintenance> License> Contacts

tab> select a contact> Notification toggle).

Once a letter is generated, the letter details will be recorded on the LP account record (LP>

Maintenance> License> History tab). Follow this process to generate an LP Letters batch.

Step by Step

1     Create a batch. 
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l Select the Letters palette in LP> Letters. This will expand the Letters palette and

display the steps in the batch process.

l Select New from the Letters batch number drop-down menu to create a new batch.

This will open the New Batch window.

l If there are open batches in the Letters process, you can create a new batch

without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The transaction date of the billing is set up in

the Generate step and the fiscal period the transactions are posted to is determined

by the Journal Entry Date entered when creating the GL Distribution Report (LP>

Letters> GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and
clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate the Letters. 
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l Open the Generate Letters window (LP> Letters> Generate).

l Check the License Type toggles for each of the license types you would like to

include in the Letters batch. All license types will be checked by default. Hold down

the SHIFT key to select multiple license types. You may decide to process a new

Letters batch for each group of similar license types. This can help prevent over-

lapping records and redundant letters.

l License types are used to group similar licenses together into logical asso-

ciations.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l Check the Licenses Status toggles for each of the license statuses you would like

to include in the Letters batch. All license statuses will be checked by default. Hold

down the SHIFT key to select multiple license statuses.

l License Statuses are primarily used for informational and reporting purposes.

Licenses can be set up to automatically change to a particular status when a

specified event takes place.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Check the License Classes toggles for each of the license classes you would like

to include in the Letters batch. All license classes will be checked by default. Hold

down the SHIFT key to select multiple license classes.

l License Classes can be used to further classify your Licenses. They are asso-

ciated with License types. For example, Licenses types could be classified as

residential, commercial, industrial or home based. License Classes are

primarily informational and are available for reporting purposes.
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l License classes are created and maintained on the License Class Main-

tenance window (LP> Maintenance> License Class).

l Check the Business Type toggles for each of the business types you would like to

include in the Letters batch. All business types will be checked by default. Hold

down the SHIFT key to select multiple business types.

l Business Types are created and maintained on the Business Type Main-

tenance window (LP> Maintenance> Business Type).

l Specify a Letter Transaction Date for the Letters batch.

l This date will be associated with the Letters line item on the License window

(LP> Maintenance> License> Select a license> History tab).

l Select a status from the Change status to drop-down menu.

l When the Letters batch is committed, any licenses or applications included

will update to the selected status.

l Enter a Description for the Letters batch. This description will display in the letters

line item on the History tab of the License Maintenance window.

l This description can be up to 60 characters long.

3     Complete the optional Filters, Tran Filters and License tabs. 
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l The Filters tab is used to filter the included licenses by category.

l Select a Category from the drop-down menu.

l Use the Application Number, License Number, Application Date, License

Start, and Expiration Date fields to further filter the licenses included in the

batch.

l The Pet tab will only be active if Pet is selected from the Category drop-down menu.

l Use these filters to limit the licenses included in the batch by pet tag number

and vaccination date.

l The Tran Filters tab is used to filter the included licenses by transaction type.

l Select a Tran Type from the drop-down menu.

l Your selection in the Tran Type field will determine which of the date

range and return fields will be enabled below.

l The Batch Process and Batch Number fields can be used to filter the trans-

actions included in the batch by specific batches.

l This is helpful when generating letters for web transactions, which are

generally set up to populate a single batch per day.

l The Licenses tab is used to add specific licenses to the batch.

l
Click the Create icon to choose a license from the License Selection win-

dow. Highlight the license you would like to add to the batch and click the Con-

firm icon to return to the Generate Letters window.

l The License tab overrides all other filters. If you use the license tab to add

licenses to the batch, only those licenses will be included.

GENERATE LP LETTERS 24



l
Click the Confirm icon to generate the letters immediately or enter a date and

time in the field next to the Confirm icon to schedule the letters to generate at a later

time.

4     Edit and print the Letters. 
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LP> Letters> Edit

Edit and Print LP Letters

Summary

After completing the Generate step you can view and edit which accounts will be receiving

LP Letters before printing.

Step by Step

1     Edit the Letters. 

l Open the Edit Letters window (LP> Letters> Edit).

l The Edit Letters window will display all of the licenses that will be included in the let-

ters batch. Licenses are included based on the filter criteria established on the Gen-

erate Letters step. Individual licenses can be removed from the batch by

highlighting a license and clicking the Delete icon .

l Each line item will display the Application Number, License Number, Customer Num-

ber, Customer Name, License Type, and License amount.

l
Click the Save icon when finished.
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2     Print the Letters. 

l The Form and Tran Date fields will populate with the values specified on the Gen-

erate step.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.

l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l The format and information included on the printed letters is determined by which

Form is selected.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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3     Print the Licenses. This is an optional step. 

l The License Print window is used to print a license for each of the licenses or per-

mits included in a Letters batch.

l Open the License Print window (LP> Letters> Licenses).

l Click the Name field label to open the License Setup Selection window.

l The License Setup Selection window will display all of the license setups cre-

ated in the application. License setups are used to configure how printed

licenses are displayed.

l License setups are created and maintained on the License Setup Main-

tenance window (LP> Maintenance> License Setup).

l The Logo Location field is used to specify where the organization logo will display

on the printed license header.

l The logo location will affect how the Header 1-3 fields specified on the license

setup will be displayed.

l The Licenses Per Page field is used to specify whether you would like to print one

license per page or three licenses per page.

l The Fee Options field will automatically be set to None if you choose to print

three licenses per page.

l The Fee Options field is used to specify whether the printed report will display no

fee information, fees only, fees and units, or fees, units and descriptions.

l The Printer Adjustment field is used to adjust where the first line of the statements

will print. If you adjust the alignment of the statements you may want to print a test

statement before printing a large batch.

EDIT AND PRINT LP LETTERS 28



l Zero is the system default. Adjusting the value up will move the first line of the

statement up on the printed page and adjusting the value down will move the

first line down.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

4     Commit the Letters batch. 

l Open the Commit Letters batch window (LP> Letters> Commit).

l Click the OK button to commit the batch.
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l Committing a letters batch will create a Letter row on the License Maintenance win-

dow (LP> Maintenance> License Maintenance> History tab). Committed letters

batches will display in black while uncommitted batches will display in red.
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LP> License Update

Update Licenses in LP
Summary

The License Update process is used to quickly and easily update multiple licenses. This

process can be used, for example, to update licenses after making changes to license-

related fees, or to change the status on a large number of licenses without editing indi-

vidual records.

Step by Step

1     Open or create a License Update batch. 

l Select the License Update palette in LP> License Update. This will expand the

License Update palette and display the steps of the batch process.

l Modify an existing batch or create a new License Update batch.

l The License Update process is a single-batch process, meaning you can only

have one active batch at a given time. If there is an open batch in the License

Update palette, you will need to either complete that batch or delete that

batch before creating a new batch.

l If you open an existing batch and return to an earlier step in the batch

process, all existing data in that batch will be overwritten.
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l Select New from the License Update batch number drop-down menu to create

a new batch. This will open the New Batch window.

l Enter a Batch Month and Batch Year. These fields default to the current cal-

endar period and are for reference only. The fiscal period of the transactions

in the batch is determined by the Journal Entry Date entered during the Gen-

erate step.

l
Click the Generate icon to populate the Batch Number field with the next

available batch number. Batch numbers are limited to five digits and must be

unique within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number

and clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the License Update

palette and press DELETE to delete a batch.

2     Generate the License Update. 

l Select the License Types you would like to include in the update batch.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed License Types. All License Types are selected by

default.

l These icons can be used to select or deselect the Fees, Statuses, and

Classes as well.
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l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l Select the Fees you would like to include in the update batch.

l The Fees selection field will only be enabled if No is selected in the Ignore

Fees drop-down menu.

l Fees are created and maintained on the Fee Maintenance window (LP> Main-

tenance> Fee).

l Select the License Statuses you would like to include in the update batch.

l License Statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Select the License Classes you would like to include in the update batch.

l License Classes are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Class).

l Select Yes in the Ignore Fees drop-down menu to disable the Fees selection field

and ignore fees in the update batch.

l Select a license status in the Change License Status To drop-down menu. This

will be the new status for all license included in the update batch.

3     Complete the Update Fees tab. 
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l Add additional fees to the licenses included in the batch.

l
Click the Create icon drop-down menu and select Add a Fee to add a fee to

the Update Fees grid. This will open the Fee Selection window.

l
Select a fee and click the Confirm icon to add that fee to the update grid.

l
Click the Delete icon to remove a fee from the update grid.

l
Click the Ellipsis icon to update the Status column on the selected fee.

l When the batch is committed, each of the licenses included will now have the

additional fees attached.

l Modify any fees attached to the licenses included in the batch.

l
Click the Create icon drop-down menu and select Modify a Fee to add a

fee to the Update Fees grid. This will open the Fee Selection window.

l
Select a fee and click the Confirm icon to add that fee to the update grid.

l
Click the Delete icon to remove a fee from the update grid.

l
Click the Ellipsis icon to update the Status column on the selected fee.

l When the batch is committed, any licenses included in the batch that have the

modified fee attached will now display the new fee status.

l Remove any fees attached to the licenses included in the batch.

l
Click the Create icon drop-down menu and select Remove a Fee to add a

fee to the Update Fees grid. This will open the Fee Selection window.

l
Select a fee and click the Confirm icon to add that fee to the update grid.
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l
Click the Delete icon to remove a fee from the update grid.

l When the batch is committed, any licenses included in the batch that had the

removed fee attached will no longer display the selected fee.

4     Complete the Filters tab. 

l The Filters tab is used to filter which licenses will be included in the License Update

batch.

l Select a Category from the drop-down menu.

l The categories displayed in the drop-down menu will be determined by the

security settings established for the current user. If All is selected, only the dis-

played categories will be included.

l Use the Application Number From and To, License Number From and To,

Application Date From and To, License Start From and To, and Expiration Date

From and To fields to filter the licenses that will be included in the batch.

l If the filtering process includes licenses that you do not want to include in the

batch, you can remove those licenses in the Edit step.

5     Complete the License tab. 
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l The License tab is used to select specific licenses that you would like included in

the batch.

l
Click the Create icon to add a license to the tab. This will open the License Selec-

tion window.

l Select the licenses you would like to add to the update batch and click the Confirm

icon .

l Only the licenses displayed on the License tab will be included in the update batch.

In order to include all licenses that meet the criteria established on the Filters tab,

leave the License tab blank.

l
Click the Confirm icon when complete.

6     Complete the Misc Update tab. 

l The Misc Update tab is used to populate a specified miscellaneous field on the

license record with a comment code comment. Comment codes are created and

maintained on the Comment Code Maintenance window (LP> Maintenance> Com-

ment Code).

l Only comment codes that were previously attached to a license can be used

to update a miscellaneous field.

l The comment that will populate the miscellaneous field is the comment added

to the license record when the comment code was attached (LP> Main-

tenance> License> open a license> Comments tab> Comment field).
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l The comment code and the comment code description will not be

included in the miscellaneous field. Only the comment entered on the

license record will be included.

l
Click the Create icon to add a comment code to the tab. This will open the Com-

ment Code Selection window.

l Select the comment code you would like to add to the tab and click the Con-

firm icon .

l If the comment code you selected is not already attached to a license,

that license will not be included in the License Update batch.

l If the comment is longer than 64 characters, it will be truncated to meet the 64

character limit.

l
Click the Ellipsis icon in the Destination column to select which miscellaneous

field the comment code comment will be populated in.

l If the miscellaneous field is already populated, the original value will be

replaced with the specified comment code comment.

l
Click the Confirm icon when complete.

7     Edit the License Update batch. 

l Open the Edit License Update window (LP> Update License> Edit).

l This window will display each of the licenses that will be included in the update

batch.
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l The Edit tab will only display those fields that will be updated for each included

license line item.

l Status updates and fee updates will appear as different line items even if they

apply to the same license.

l The Error tab will display any errors that occurred when the update batch was gen-

erated. Return to the Generate step to update the batch settings.

l
Highlight a license update line item and click the Delete icon to remove that

update from the batch.

l
Click the Save icon after making any changes to the batch.

8     Commit the License Update batch. 

l Open the Commit License Update window (LP> Update Licenses> Commit).

l Click the OK button to commit the batch. The information from the batch is now per-

manently posted to the General Ledger and the customer accounts.

l The updated license status and any changes to the fees attached to the license will

now display on the License Maintenance window (LP> Maintenance> License).

UPDATE LICENSES IN LP 38



LP> Maintenance> Alert Code

Alert Code Maintenance

Summary

Alert codes can be set up to alert users when they select and edit a license from within the

LP module or when the license is accessed via the Cash Receipts interface. The alert win-

dow will display the system that the license was accessed from, the alert code, the expir-

ation date for the alert code, and any comments added to the alert code. When the user

closes the alert window, the license that they selected will open.

The alert code details specified when the alert code is created are used only as a template.

These details can be edited when the alert code is attached to a license. Because these

details can be edited on each license, any changes made to an alert code on the Alert

Code Maintenance window will not automatically update on the licenses that the edited

alert code was previously attached to.

Step by Step

1     View the existing alert codes. 
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l Open the Alert Code Maintenance window (LP> Maintenance> Alert Code).

l The left section of the window will display all of the alert codes that have been cre-

ated in the application. Select an alert code in the left section of the window and the

information attached to that alert code will populate in the Maintenance section to

the right.

l
Highlight an alert code and press DELETE or click the Delete icon if you would

like to delete an alert code.

l You cannot delete an alert code that is attached to an existing license.

l
Press INSERT or click the Create icon if you would like to create a new alert

code. This will create a new line item in the left section of the window and the fields

in the Maintenance section will be enabled to enter the alert code information.

2     Create a new alert code. 

l Enter a unique Alert Code. Once the new alert code is saved, this field cannot be

edited.

l The alert code can be up to 20 characters long.

l Enter a Description for the new alert code.

l This field can be up to 60 characters long.

l Specify the alert code Duration in days.

l The default start date for an alert code is the day it is attached to the license.

The alert code expiration date is the start date plus the Duration. This value
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can be between 0 and 999.

l Enter a Comment on the alert code.

l The Comment will display when the alert is activated. The field can be up to

1024 characters.

l Check the Selection Alert toggle to activate the alert message when the license is

selected for a batch process, such as LP Letters.

l The selection alert will not activate if the license is included in a batch as a

member of a group select during a batch generate step.

l Check the Maintenance Alert toggle to activate the alert message when the

license is opened from any window where the license details can be maintained or

edited.

l Check the CR Receipt Alert toggle to activate the alert message when the license

is selected from the CR Cash Entry search window.

l
Click the Save icon to save the new alert code.
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LP> Maintenance> Approval Type

Approval Type Maintenance

Summary

Approval Types are used to create approval steps on LP licenses. They can be set up to

notify a particular user, update the license status, apply a fee or attach an alert code to the

license when the approval step is approved or failed.

Once an approval type is created, it can be attached to a license on the License Main-

tenance window (LP> Maintenance> License> Approval tab).

Step by Step

1     View the existing Approval Type codes. 

l Open the Approval Type Selection window (LP> Maintenance> Approval Type).

l This window will display all of the approval type codes created in the application.

l
Highlight an approval type and press DELETE or click the Delete icon if you

would like to delete an approval type.

l You cannot delete an approval type that is attached to an existing license.
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l
Press ENTER or click the Modify icon to edit an existing approval type.

l
Press INSERT or click the Create icon if you would like to create a new approval

type code. This will open the Approval Type Maintenance window.

2     Create a new Approval Type code. 

l Enter a unique Approval Type code. Be as descriptive as possible as this is the

primary way to differentiate between approval steps on the License Maintenance

window.

l This code can be up to 20 characters long.

l Enter an optional Description for the approval type.

l This field can accommodate up to 60 characters.

l Specify the duration of the approval type in the Days to Expire field.

l When the approval type is attached to a license as an approval step, the expir-

ation date of that approval step will be the date it is attached plus the duration

specified in this field.

l This duration must be between zero and 999 days.

l Enter any Notes for the approval type.

l This field can accommodate up to 512 characters.

l The Notify drop-down menu is used to determine which users will be notified when

an approval step on a license requires their attention. By selecting queue, role or

user, the default value set up below will be the notification recipient.
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l The Default Queue, Default Role and Default User fields are used to spe-

cify a default queue, role or user that will be notified when an approval step

requires attention.

l Queues are created and maintained on the Queue Maintenance win-

dow (LP> Maintenance> Queue).

l Roles are created and maintained on the Role Maintenance window

(SS> Security> Role).

l Users are created and maintained on the User Maintenance window

(SS> Security> User).

l The Status on Approve and Status on Fail fields are used to specify what status

the license will change to when the approval step is approved or failed.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l These approval and fail fields are optional. Each of these values can be spe-

cified when the approval step is added to the license.

l The Fee on Approve and Fee on Fail fields are used to apply a fee to the license

when the approval step is approved or failed.

l The Alert on Approve and Alert on Fail fields are used to attach an alert to the

license when it is approved or failed.

l An alert code attached to the license upon approval or failure will behave in

the same manner as any other alert attached to the license.

l
Click the Save icon to save the new approval type code.
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LP> Maintenance> Business Classes

Create a Business Class in LP

Summary

Business classes and business types are optional divisions you can attach to licenses to

categorize LP licenses. Business classes are not directly attached to licenses. Instead,

business classes are attached to business types, and business types are then attached to

LP licenses in the License Maintenance window (LP> Maintenance> License> Open or cre-

ate a license> General tab> License Type field).

A business class is a broad group and can be attached to many unique business types, so

business types are generally used as a sub-grouping of business classes. For example, if

you would like to track the issuance of several types of restaurant licenses, you could cre-

ate a restaurant business class, and have business types such as fast food, sit-down res-

taurant, and restaurant with bar.

Step by Step

1     Open the Business Class Selection window. 
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l The Business Class Selection window (LP> Maintenance> Business Class) will

display all of the business classes created in the application.

l
Highlight a business class and click the Delete icon to delete the business class.

l If you delete a business class that has attached business types, those busi-

ness types will no longer be associated with a business class.

l
Highlight a business class and click the Modify icon or click the Create icon

to open the Business Class Maintenance window.

2     Create a Business Class.

l Enter a unique business class name in the Class field. This name can be up to 20

alphanumeric characters.

l Once a business class code is created it cannot be edited.

l Enter a business class Description. This optional field can be up to 60 alpha-

numeric characters.

l
Click the Create icon to associate a business type with the new business class.

l This will open the Business Type Selection window.

l
Highlight a business type and click the Confirm icon to return to the Busi-

ness Class Maintenance window.
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l Each business type can only be associated with one business class. If you

attempt to attach a business type to a second business class a validation

error window will display which class the type is already attached to.

l
Click the Save icon to save the new business class.
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LP> Maintenance> Business Types

Create a Business Type in LP

Summary

The Business Type Maintenance window is used to create and maintain business types.

Multiple business types can be organized under one Business Class grouping. Business

Types allow you to provide more detailed reporting of businesses licensed in your organ-

ization. An example of a Business Class would be Contractor and a corresponding Busi-

ness Type would be Plumber. This type of set up would allow you to print a report on all the

Contractors or just the Plumbers that have licenses.

Business types contain a user defined code and description, SIC (Standard Industrial Clas-

sification System) code, and NAICS (North American Industry Classification System) code.

Step by Step

1 View the existing business types. 

l Open the Business Type Maintenance window (LP> Maintenance> Business

Type).
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l The left section of the window will display all of the business types that have been

created in the application. Select a business type in the left section of the window

and the information attached to that business type will populate in the Maintenance

section to the right.

l
Highlight a business type and press DELETE or click the Delete icon if you

would like to delete a business type.

l You cannot delete a business type that is attached to a class (LP> Main-

tenance> Business Class> Open a class). If you try to delete a business type

that is attached to another record, an information window will open displaying

the record it is attached to.

l
Press INSERT or click the Create icon if you would like to create a new business

type. This will create a new line item in the left hand portion of the window and the

fields in the Maintenance section will be enabled to enter the business type inform-

ation.

2 Create or modify a business type. 

l The Code field is used to identify a unique business type. The business code can be

up to eight characters long.

l This is the only required field in the window. All other fields are optional.

l Once a business type code is created it cannot be edited.

l The Description field is used to enter a description on the business type. The

description can be up to 60 characters long.
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l The SIC field is used to enter a Standard Industrial Classification System code. This

code can be up to 40 characters long.

l SIC codes are used to classify industries and are established by the U.S.

Government.

l The NAICS field is used to enter a North American Industry Classification System

code. This code can be up to 40 characters long.

l NAICS codes are used to classify industrial activity in the United States,

Canada and Mexico.

l
Press ENTER or click the Save icon to save the business type.

l Once a business type has been created, you can add it to a class using the Class

Maintenance window (LP> Maintenance> Business Class> Open a class).

l Each business type can only be added to one business class.
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LP> Maintenance> Comment Code

Comment Code Maintenance

Summary

Comments can be attached to licenses to track any notes about the license including

phone conversations, complaints, and requests. Comments are added to LP license

accounts in the License Maintenance window (LP> Maintenance> License> Open a

license> Comments tab).

Step by Step

1     View the existing comment codes. 

l Open the Comment Code Maintenance window (LP> Maintenance> Comment

Code).

l The left section of the window will display all of the comment codes that have been

created in the application. Select a comment code in the left section of the window

and the information attached to that comment code will populate in the Maintenance

section to the right.
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l
Highlight a comment code and press DELETE or click the Delete icon if you

would like to delete a comment code.

l You cannot delete a comment code that is attached to a license.

l
Press INSERT or click the Create icon if you would like to create a new com-

ment code. This will create a new line item in the left section of the window and the

fields in the Maintenance section will be enabled to enter the comment code inform-

ation.

2     Create or modify a comment code. 

l The Code field is used to identify a unique comment code. The comment code can

be up to 20 characters long.

l Once a comment code has been created it cannot be changed.

l The Description field is used to enter a description on the comment code. This

optional field can be up to 60 characters long.

l
Press ENTER or click the Save icon to save the comment code.
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LP> Maintenance> Contact Type

Create a Contact in LP

Summary

Contact Types are contact categories that can be used to attach contacts to licenses. You

can reduce data entry by creating contact types for the most common contacts you use.

Contacts can be attached to licenses on the Contacts tab of the License Maintenance win-

dow in order to associate particular individuals with particular licenses.

Follow this process to create a contact type in the LP module. The contact types you create

in the LP module will also be available in the Business Tax module.

Step by Step

1     Open the Contact Type Maintenance window. 

l The Contact Type Maintenance window (LP> Maintenance> Contact Type) will

display a list of all the contact types created in the application.
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l
Click the Delete icon to delete a contact type.

l You cannot delete contact types that are attached to existing licenses or BT

businesses.

l
Click on the Create icon to add a new contact type.

2     Create a Contact Type. 

l Enter a contact type in the Contact Type field. This code can be up to 20 alpha-

numeric characters. This field will not be enabled and available for editing after the

contact type has been saved.

l Enter an optional description in the Description field. The Description can be up to

60 alphanumeric characters.

l
Click on the Save icon or press ENTER to save the contact type.

l Once a contact type is created, it will be accessible from the Contacts tab of

the License Maintenance window.
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LP> Maintenance> Fees

Create a Fee in LP

Summary

The Fee Maintenance window is used to create and maintain fee codes. Fees are user-

defined codes used to generate an associated transaction on a license.

Step by Step

1     View the existing fees. 

l The Fee Selection window (LP> Maintenance> Fees) displays all of the fees cre-

ated in the LP Module.

l
Highlight a fee and click the Delete icon or press DELETE to delete the selected

fee.

l Fees that are attached to license types or other fees as late or penalty fees

cannot be deleted.

l
Highlight a fee and click the Modify icon to edit the selected fee.

l
Click the Create icon to open the Fee Maintenance window.
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2     Create a new fee. 

l Enter a unique Code for the new fee. The fee code can be up to eight alphanumeric

characters.

l Once a fee is created, the Code field cannot be changed.

l Enter a fee code Description. This optional field can be up to 60 alphanumeric char-

acters.

l Select a Fee Type from the drop-down menu.

l The available fee types are Deposit, Penalty, Standard and Tax. The fee type

selected will determine which of the remaining fields are enabled.

l Enter a Fee Unit Type or click the field label to choose one from a list.

l When charges are generated for a fee unit type based license, the license will

bill, partially or wholly, based on the number of units specified under the

Rates section. If no units are specified, no charges will be generated for this

fee.

l The Fee Unit Type field will only be active when creating a Standard fee.

l Fee unit types are created and maintained on the Fee Unit Type Maintenance

window (LP> Maintenance> Fee Unit Type).

l Enter an amount in the Fixed Amount field if this fee code will be used for a trans-

action that is usually the same dollar amount.

l The Fixed Amount field will only be active when creating a Deposit or Stand-

ard fee.
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l Enter a Payment Priority or click the field label to choose one from a list. This is a

required field.

l Payment priority codes determine the order in which fees are paid. Payment

priorities are created and maintained on the Payment Priority Maintenance

window (LP> Maintenance> Payment Priority).

l Attach an AR Account, Revenue Account and Cash Account to the fee. These

accounts must be designated in order to create the fee.

l When charges are generated, the system will debit the AR Account and credit

the Revenue Account.

Debit Credit

AR Fee

Revenue Fee

l When payment is received, the system will debit the Cash Account and credit

the AR Account.

Debit Credit

Cash Fee

AR Fee

l The system will not validate what type of account was entered, so you can

enter any account you choose.
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l If you would like to attach a Late Fee to the new fee, enter one in the Late Fee field

or click the field label to choose one from a list.

l If the Fee Selection window does not display a late fee, you will need to create

one before it can be attached to another fee.

l Select a Prorate option from the drop-down menu.

l Select Fixed to base prorated fee charges on the value in the Fixed Amount

field.

l Select Fixed and Tier to base prorated fee charges on both the value in the

Fixed Amount field and the applicable tier charges established in the Rates

section.

l Select Tier to base prorated fee charges on the applicable tier charges estab-

lished in the Rates section.

l Fees will only be prorated when the fee is included on a new license, not an

application, issued through the Cash Receipts LP interface.

l The Prorate Period field will only be active if you have selected a prorate option.

l Select Daily, Monthly, Quarterly or Semi-Annually to determine the prorate

period.

l Add fees to the Tax Fees field.

l The Tax Fees field will only be active if the Fee Type is set to Penalty or Stand-

ard.

l
Click the Create icon drop-down menu and select New Tax Fee to add tax

fees to this field. This will open a Fee Selection window.

l If the Fee Selection window does not display a tax fee you will need to create

one.
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l By default the Active toggle will be checked. If you do not want users to have

access to this fee, un-check this toggle. This is usually done when a fee is no longer

in use.

l Check the Accumulate rates for each tier toggle to accumulate rate amounts that

fall across individual rate tiers.

l For example, you might set up a late payment penalty fee tier system that

looks like this:

l 0 - 15 days late = $1 per day

l 15 - 30 days late = $2 per day

l 30 - 45 days late = $3 per day

l If the Accumulate rates for each tier toggle is not checked, a penalty
fee for a bill that is 40 days overdue would be $120 as it falls into the 30

- 45 days late tier (40 days x $3 per day).

l If the Accumulate rates for each tier toggle is checked, a penalty fee
for a bill that is 40 days overdue would be $75 as it is spread over all

three tiers (15 days x $1 per day + 15 days x $2 per day + 10 days x $3

per day).

l This toggle will not be active if the Fee Type is set to Deposit or Penalty.

3     Add rates to the fee. 

l The Rates section of the Fee Maintenance window is used in conjunction with the

fee units specified on the fee. The rates section tells the system how much to
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charge for each unit specified on the license. This section will not be enabled when

creating a Deposit fee.

l
Click the Create icon drop-down menu and select New Rate to create a new rate

line item.

l Enter the range values in the Greater Than and Through fields.

l These values will designate the lower and upper limits of each penalty fee tier.

l For example, a three-tier late fee might include ranges of 0 - 15 days, 15 - 30

days and 30 - 45 days. In this case, you would need to create a new rate line

item for each of these ranges. The high limit a lower tier should match the low

limit of the next tier.

l Check the Or Over toggle if you want the range to apply to unit values that are

greater than the upper range entered in the Through field.

l Enter a Rate for the fee.

l The Rate applies to both Percentage and Per Unit fees.

l To create a Percentage fee, check the Percentage toggle and enter the per-

centage to be charged by the fee in the Rate field.

l On Penalty fees, the percentage in the Rate field will be multiplied by

the past due amount.

l To create a Per Unit fee, check the Per Unit toggle and enter the per unit

charge in the Rate field.

l This is generally the amount you would like to charge for every unit in

the range. The value in the Every field will determine how often the

amount in the Rate field is charged. For example, if you want to charge

$1 per day for every day a fee is overdue, you would enter a 1 in the

Every field. If you are using a tier system, the rate might be $1 per day
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for 0 - 15 days overdue, $2 per day for 15 - 30 days overdue and $3 per

day for 30 - 45 days overdue.

l
Click the Save icon when complete.
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LP> Maintenance> Fee Unit Type

Fee Unit Type Maintenance

Summary

The Fee Unit Type Maintenance window is used to define what units will be used to assess

license and permit fees. A fee unit type is a user-defined unit used to compute how those

fees are totaled.

Step by Step

1     View the existing Fee Unit Types. 

l Open the Fee Unit Type Maintenance window (LP> Maintenance> Fee Unit Type).

l The left section of the window will display all of the fee unit types that have been cre-

ated in the LP module. Select a fee unit type in the left section of the window and the

information attached to that fee unit type will populate in the Maintenance section to

the right.

l
Highlight a fee unit type and press DELETE or click the Delete icon if you would

like to delete a fee unit type.

l You cannot delete a fee unit type that is attached to an active fee.
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l
Press INSERT or click the Create icon if you would like to create a new fee unit

type. This will create a new line item in the left hand portion of the window and the

fields in the Maintenance section will be enabled to enter the fee unit type inform-

ation.

2     Create a new Fee Unit Type. 

l The Unit Type field is used to identify a unique fee unit type. The unit type code can

be up to 20 alphanumeric characters.

l Once a Unit Type is saved, it cannot be edited.

l The Description field is used to enter a description on the fee unit type. This

optional description can be up to 60 characters long.

l
Click the Save icon or press ENTER to save the fee unit type.
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LP> Maintenance> Forms

Create a Form in LP

Summary

Forms refer to Microsoft Word documents that, through the use of merge fields, allow users

to pull data from the application and customize how that data is displayed on the forms.

Forms will be saved in the Springbrook folder on your server at the path specified when the

application was installed (SS> Utilities> System Setup> System tab> Archive Directory

field).

The forms will be saved as .sbw files in this folder and should not be edited to avoid cor-

ruption. Forms can be attached to various application elements through the module pro-

cess and maintenance palettes.

Follow this process to create forms to attach to License and Permits processes. The forms

set up in the LP module will not be accessible in other modules that use forms.

Step by Step

1     View the existing Forms. 
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l Open the Word Merge Form Selection window (LP> Maintenance> Forms).

l The Word Merge Form Selection window will display all of the forms created in the

application. Use the search criteria fields to filter the displayed forms.

l
Highlight a form and click the Preview icon to view the selected form. This will

open the MS Word document in a new window.

l
Highlight a form and click the Copy icon to copy the selected form. This will cre-

ate a copy of the original form.

l
Highlight a form and click the Delete icon or press DELETE to delete the selec-

ted form.

l
Highlight a form and click the Modify icon or press ENTER to open and edit an

existing form.

l
Click the Create icon or press INSERT to create a new form. This will open the

Word Merge Form Maintenance window.

2     Create a new Form. 

l Enter a unique Form Name for the form. The field can be up to 32 characters long.

Once the form has been saved, you will not be able to edit this field.

l Enter an optional form Description.

l The System field will automatically populate with LP. This cannot be edited.
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l Use the Process drop-down menu to select which LP process the form will be used

in. Once the batch process is specified, the form will only be available in that pro-

cess.

l
After you have specified the form details, click the Create icon to create the

form. This will open a new Word document.

l Once the Word document is open, use the insert merge fields command in

Word to specify the data fields you want displayed on the form. For instance,

the merge field Expiration_Date is the license expiration date. By inserting

this merge field into the Word document, and then attaching the form to an LP

process, the form will display the data found in the Expiration Date field of the

license included in the process.

l Images, charts, tables, etc. can also be inserted into the Word document.

l Once you are finished creating/modifying your form, be sure to save the form both

on the Word document (File> Save) and using the Save icon on the Form Main-

tenance window.

l The new form will now be available when creating form letters in the specified LP

process.
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LP> Maintenance> Licenses

Create a License in LP

Summary

Follow this process to create a license or application in the LP module.

Step by Step

1     View the existing licenses. 

l The License Selection window (LP> Maintenance> Licenses) will display all

licenses and open applications that have been created in the LP module.

l Enter information in the fields in the Search Criteria section of the window and click

the Refresh icon to filter the licenses and applications that will display in the win-

dow.

l
Highlight a license or application and click the Delete icon to delete the selected

license.

l A license or application that has been issued to an active customer, a cus-

tomer in an open batch or an AP vendor cannot be deleted.
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l
Highlight a license or application and click the Modify icon to open an existing

license.

l
Click the Create icon to create a new license or application.

2     Create a new license or application. 

l
Click the Create icon to open the License Maintenance window.

l Complete each of the tabs on the License Maintenance window.

l
If you are creating a license from an existing application, click the Generate icon

and save the new license.

3     Complete the General tab. 

l Click the Operation drop-down menu to specify whether this will be a new Applic-

ation or a new License.

l Click the Category drop-down menu to select Business, Pet or Vehicle as the cat-

egory for the license.

l The Category selection will determine what information is displayed to the

right.
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l Click the License Type field label to specify a license type for the license or applic-

ation. Every license or application must be associated with a license type.

l License types make creating licenses simpler and less time consuming.

License types dictate the fee codes and forms that will be used on the license.

By creating a number of different license types based on these char-

acteristics, you are not required to attach fee codes, forms, and other mis-

cellaneous information to each license you create. You simply attach the

license type to the license that should contain this information.

l The use of license types also allows you to classify similar licenses with each

other for reporting purposes. License types are created and maintained on

the License Type Maintenance window (LP> Maintenance> License Type

Maintenance).

l The Application Number field will automatically populate with the next available

application number when the application is saved.

l Enter a License Number if you are creating a new license.

l The License Number field will not be active if the attached License Type is set

up for auto numbering (LP> Maintenance> License Type> Auto Number field).

l Enter a Business Number or click the field label to choose one from a list. Busi-

nesses are created and maintained on the Business Maintenance window (BT>

Maintenance> Business).

l A business can be attached to the license after the license has been created.

l Enter the company name in the Doing Business As field.

l The Customer Number, Customer Name, Lot Number, Service Address, Lot

Owner Name and Lot Owner Address fields will automatically populate with the

information associated with the selected business number.

CREATE A LICENSE IN LP 69



l If the Customer Number does not automatically populate, or if you are cre-

ating a license or application for an individual rather than a business, you

must click the field label and select a customer from the list. This is a required

field.

l The Outstanding Bills, Unapplied Credits, and License Balance fields are inact-

ive and will populate with financial data as transactions are processed on the

license.

l TheWeb Registration Key field is used to record the registration key if the license

has been set up to use the Business Licensing or Business Licensing and Tax

online applications.

l
Click the Generate Web Registration Key icon above to generate a regis-

tration key for the selected license.

l Click the License Status field label to specify a license status for the license.

l The License Status field will automatically populate with the status specified

on the License Type selected above.

l The license status will automatically update as the license progresses

through events specified on the License Type Maintenance window. For

example, if the selected license type has a Status On Application of

"APP" and a Status On New License of "NEW", the License Status field

will display "APP" if it is created as an application and "NEW" if it is cre-

ated as a new license or created from the application.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status Maintenance).

l Select an Application Date from the drop-down menu. This field will default to

today's date but can be edited.
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l The Issue Date is the date that the license is physically delivered to the business or

customer. This date does not have to be the same as the Start Date.

l The Issue Date field will automatically update to today's date when generating

a license from an existing application.

l The Start Date field will automatically populate with the start date specified on the

License Type selected above. This is the date that the license is considered active

and the license term begins.

l The Duration, Duration Units, and Expiration Date fields will populate with the

information attached to the selected License Type.

l The Expiration Date is tied to the Start Date, and will reflect a time period

established by the values in the Duration and Duration Units fields.

l The Print Date field will automatically populate with the last date that the license

was printed.

l Enter an optional Description for the license.

l This field can be up to 1024 characters long.

l The License History Summary will display a brief summary of the license history

displayed on the History tab. This is not meant to be detailed and comprehensive. It

is simply meant to provide a quick overview of the important dates in the license his-

tory.

l Check the Do not renew toggle to exclude this license from a renewal letters batch.

l Check the Notification toggle to generate a letter for the customer attached to the

license when the license is included in an LP Letters batch.

l Check the Charge Exempt toggle if this license is being issued to an organization

that has been deemed exempt from the standard licensing fees.
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l This toggle can be used to issue supplementary licenses that must be asso-

ciated with a primary license but do not require additional fees. This toggle is

also often associated with organizations such as churches or non-profits.

l Licenses set up as charge exempt cannot be included in the renewals pro-

cess.

4     Complete the category-specific section of the General tab. 

l The category-specify section of the General tab will change based on the selection

in the Category drop-down menu.

l Add business types to the license or application if Business is selected.

l
Click the Create icon to attach a business type to the license. This will

open the Business Types selection window.

l The Business Types selection window will display all business types

that have been created in the LP module. Business types are created

on the Business Type Maintenance window (LP> Maintenance> Busi-

ness Types).

l
Highlight a business type and click the Confirm icon to attach a busi-

ness type to the license.

l If Pet or Vehicle is selected from the Category drop-down menu, enter the pet or

vehicle information in the available fields.
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5     Transmit Customer or Lot data to a web site. 

l
Click the Launch URL icon drop-down menu and select a URL type code to

transmit data from the customer or lot records associated with the license to the

web site attached to the URL type code.

l This icon is accessible from any tab on the License Maintenance window.

l If your organization uses third-party web sites for tasks such as lot mapping or

license applicant background checks, URL type codes can help improve efficiency

by reducing data entry.

l URL type codes are created and maintained on the URL Setup window

(SS> Maintenance> URL Setup).

6     Complete the Fees tab. 

l The Fees tab will display any fees attached to the license or application.

l All fees attached to the License Type selected on the General tab will be dis-

played in the data grid.

l Only those fees that are associated with the same status as the license or not

associated with a status at all will be applicable in Cash Receipts.

l
Click the Create icon to add a Fee to the license.

l Edit the Number of Units field if desired. If the License Type selected has a

fee code attached that uses units for rate calculations, the appropriate Unit

Type will be displayed.
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l The Amount field will automatically update to display the total amount

incurred by the fee.

l Fees are created and maintained on the Fee Maintenance window (LP> Main-

tenance> Fee).

7     Complete the History tab. 

l The History tab is used to track the committed and uncommitted transaction line

items on the selected account. The lower section of the tab displays the transaction

type details.

l Uncommitted transactions will display in red and committed transactions will display

in black. Committed transactions will also have a date in the Post Date column.

l The Post Date column displays the date that the transaction has been com-

mitted. This is the date the batch was committed, it is not necessarily the

same as the date the transactions are posted to the general ledger or the

transaction date.

l Click the Expand button to view the line item detail of a transaction.

l You can export the transactions that display in the window to a MS Excel spread-

sheet by right clicking on the data in the tab and selecting Export grid contents to

Excel. All transaction line items will display on the export, even line items that have

not been expanded. This feature allows you to create a quick report of the history of

a customer account.

l The History tab will not display any license history until the first transaction is

attached to that license.
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8     Complete the Approval tab. 

l The Approval tab of the License Maintenance window allows you to attach

approval steps to the license.

l Approval types are created and maintained on the Approval Type Main-

tenance window (LP> Maintenance> Approval Type).

l
Click the Create icon drop-down menu and select Add Approval to open the

Approval Type Selection window.

l The Approval Type Selection window will display all of the approval types cre-

ated in the LP module. Select an approval type and click the Confirm icon

to return to the Approval tab.

l Each approval type attached to the license constitutes a new approval step. These

approval steps can be set up to notify a particular user, update the license status,

apply a fee or attach an alert code to the license when the step is approved or failed.

l If multiple approval steps should be started at the same time, assign the same

step number to those steps.

l
Click the Create icon drop-down menu and select Add Approval Contact to add

a contact to the approval step.

l Contacts are created and maintained on the Contact Maintenance window

(LP> Maintenance> Contact Type).

l
Use the Up and Down icons to reorder the approval steps.

CREATE A LICENSE IN LP 75



9     Complete the Comments tab. 

l The Comments tab of the License Maintenance window allows you to insert and

store comments about the selected license.

l
Click the Create icon to add a comment code to the account. This will open the

Comment Code Selection window.

l
Highlight a comment code and click the Confirm icon to attach the code to

the account.

l Enter a detailed comment in the Comment field. This is an optional field and

can be up to 512 alphanumeric characters long.

l The Date Created field will default to today's date.

l Comment codes are created and maintained on the Comment Code Maintenance

window (LP> Maintenance> Comment Code).

10     Complete the Contacts tab. 

l The Contacts tab of the License Maintenance window allows you to insert and

store information about individuals who are associated with the selected license.

l All the contacts currently attached to the business will display on this tab.

l
Use the filter options and click the Refresh icon to filter the displayed con-

tacts.

l
Highlight a contact and click the Delete icon to remove the selected contact.
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l
Click the Create icon to attach a new contact to the license. This will open the

Contacts selection window.

l
Select a contact and click the Confirm icon to attach a contact to the

license.

l Contacts are created and maintained on the Contact Maintenance window (LP>

Maintenance> Contact Type).

11     Complete the Forms tab. 

l The Forms tab will display any forms attached to the license.

l
Click the Create icon and select one of the available form letters to attach that

form letter to the license.

l Forms are created and maintained on the Forms Maintenance window (LP> Main-

tenance> Forms).

12     Complete the Alert tab. 

l The Alert tab will display all of the existing alerts attached to the license.

l
Highlight an alert code and click the Delete icon or press DELETE to remove the

selected alert code from the license.
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l
Highlight an alert code and click the Modify icon or press ENTER to edit the

selected alert code.

l
Click the Create icon or press INSERT to attach a new alert code to the license.

This will open the Alert Code Selection window.

l
Select an alert code and click the Confirm icon to add the selected alert

code to the license.

l Alert codes are created and maintained on the Alert Code Maintenance win-

dow (BP> Maintenance> Alert Code).

l The Description field will automatically populate with the description attached to

the selected alert code.

l Enter an Alert Date for the new alert code. This represents the date that the alert

code becomes active.

l This field will automatically populate with today's date.

l The Expiration Date is calculated by adding the alert duration specified on the

selected alert code to the date specified in the Alert Date field. If the Alert Date is

updated, the Expiration Date will automatically update according to this calculation.

l The Expiration Date cannot be prior to the Alert Date.

l The Comment field will populate with the comment attached to the selected alert

code.

l Check the Selection Alert toggle to activate the alert message when the license is

individually selected for a batch processes such as LP Letters.

l The selection alert will not activate if the license is included in a batch as a

member of a group select during a batch generate step.
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l Check the Maintenance Alert toggle to activate the alert message when the

license is opened from any window where the license details can be maintained or

edited.

l Check the CR Receipt Alert toggle to activate the alert message when the license

is selected from the CR Cash Entry search window.

13     Complete the Miscellaneous tab. 

l The Miscellaneous tab allows you to build your own tables of data if there is inform-

ation you want to track. This information is optional and user-defined.

l Miscellaneous field labels are maintained on the Miscellaneous Field Label Main-

tenance window (SS> Utilities> Miscellaneous Field Labels).

14     Track any changes made to the license record. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit history.

l The Audit Trail section will provide details about any changes made to a license

record including the date of the change, type of change made, user that made the

change, and data table that was edited.
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15     Print the license or permit. 

l
Click the Print icon to print the license or permit. This will open the License

Print window.

l Click the Name field label to open the License Setup Selection window.

l The License Setup Selection window will display all of the license setups cre-

ated in the application. License setups are used to configure how printed

licenses are displayed.

l License setups are created and maintained on the License Setup Main-

tenance window (LP> Maintenance> License Setup).

l The Logo Location field is used to specify where the organization logo will display

on the printed license header.

l The logo location will affect how the Header 1-3 fields specified on the license

setup will be displayed.

l The Licenses Per Page field is used to specify whether you would like to print one

license per page or three licenses per page. Because you are only printing the open

license, only one license will print on the top 1/3 of the page.

l The Fee Options field will automatically be set to None if you choose to print

three licenses per page.

l The Fee Options field is used to specify whether the printed report will display no

fee information, fees only, fees and units, or fees, units and descriptions.

l The Printer Adjustment field is used to adjust where the first line of the statements

will print. If you adjust the alignment of the statements you may want to print a test

statement before printing a large batch.
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l Zero is the system default. Adjusting the value up will move the first line of the

statement up on the printed page and adjusting the value down will move the

first line down.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Maintenance> License Class

Create a License Class in LP

Summary

License Classes can be used to further classify your Licenses. They are associated with

License types. For example, groups of Licenses types could be classified as residential,

commercial, industrial or home based. License Classes are primarily informational and are

available for reporting purposes.

Step by Step

1     View the existing license classes. 

l Open the License Class Maintenance window (LP> Maintenance> License

Class).

l The left section of the window will display all of the license classes that have been

created in the application. Select a license class in the left section of the window

and the information attached to that license class will populate in the Maintenance

section to the right.
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l
Highlight a license class and press DELETE or click the Delete icon if you would

like to delete a license class.

l A license class cannot be deleted if it is attached to a license type. License

classes are attached to license types on the License Type Maintenance win-

dow (LP> Maintenance> License Type> Open a license type> License Class

field).

l
Press INSERT or click the Create icon if you would like to create a new license

class. This will create a new line item in the left section of the window and the fields

in the Maintenance section to the right will be enabled.

2     Create a new license class. 

l The Class field is used to identify a unique license class. The class field can be up

to 20 alphanumeric characters long.

l The Description field is used to enter a description for the license class. This

optional description can be up to 60 alphanumeric characters long.

l
Click the Save icon when complete.
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LP> Maintenance> License Setup

License Setup Maintenance

Summary

The License Setup Maintenance window is used to configure how printed licenses and per-

mits will be displayed.

Step by Step

1     Open the License Setup Maintenance window (LP> Maintenance> License Setup). 

l The License Setup Maintenance window will display all of the existing license

setups. Highlight a license setup on the left side of the window and the setup details

will be displayed in the Maintenance section on the right.

l
Highlight a license setup and click the Delete icon the delete the selected

license setup.

l
Click the Create icon to create a new license setup. This will create a new line

item on the left side of the window and enable the Maintenance fields on the right.
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2     Create a new License Setup. 

l Enter a unique Name for the license setup.

l Once you save the new license setup, the name field cannot be edited. This

field can be up to 50 characters.

l This is the only required field when creating a new license setup.

l Enter an optional Description for the new license setup.

l This field can be up to 60 characters long.

l The Name and Description fields are for identification purposes only and will

not be displayed on the printed license or permit.

l The Header 1-5 fields are used to add up to five header fields to the printed license

or permit. Each of the header fields can accommodate up to 20 characters.

l The Header 1-3 fields will be displayed along the top of the license, with

Header 1 positioned at the top left, Header 2 at the top right, and Header 3

just below Header 2. These are the default positions, and if you elect to

include an organization logo when printing the license or permit, these pos-

itions will be adjusted accordingly.

l The Header 4 field will be displayed on the right side of the license, just below

the Memo field.

l The Header 5 field will be displayed on the right side of the license, below the

license details.

l Enter a Memo for the license setup.

l The memo will be displayed just below the license or permit header.

l This field can be up to 500 characters long.
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l
Click the Save icon when complete.

l When you print a license from the License Maintenance window (LP> Main-

tenance> License> open a license> Print icon ), the License Print window will

open. From this window, you will be able to select which License Setup you would

like to use to print the license.

l Print a test license or permit using the new license setup and make any adjustments

that are needed.
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LP> Maintenance> License Status
Maintenance

License Status Maintenance

Summary

License Statuses are primarily used for informational and reporting purposes. Licenses

can be set up to automatically change to a particular status when a specified event takes

place. For example, you could create OutPay and PayFull statuses. Any license that has

been approved but not paid in full would be associated with the OutPay (outstanding pay-

ments due) status. Once the license fees are paid in full, the license status would switch to

PayFull (paid in full).

Step by Step

1     View the existing license statuses. 

l Open the License Status Maintenance window (LP> Maintenance> License

Status).

l The left section of the window will display all of the license statuses that have been

created in the application. Select a license status in the left section of the window
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and the information attached to that license status will populate in the Maintenance

section to the right.

l
Highlight a license status and press DELETE or click the Delete icon if you

would like to delete a license status.

l A license status cannot be deleted if it is attached to an active license.

License statuses are attached to licenses on the License Maintenance win-

dow (LP> Maintenance> License).

l
Press INSERT or click the Create icon if you would like to create a new license

status. This will create a new line item in the left section of the window and the fields

in the Maintenance section to the right will be enabled.

2     Create a new license status. 

l The Status field is used to identify a unique license status. The status field can be

up to 10 alphanumeric characters long.

l The Description field is used to enter a description on the license status. This

optional description can be up to 60 alphanumeric characters long.

l
Click the Save icon when complete.
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LP> Maintenance> License Types

Create a License Type in LP

Summary

A License Type is a collection of fee codes, forms and other miscellaneous information that

is used in conjunction with a particular type of license. By creating a number of license

types, you can attach the license type to each new license or application you create rather

than having to attach fee codes, forms, and other info to each new license or application

created. The use of License Types makes the creation of licenses more efficient. It also

lends itself to various forms of license classification for reporting purposes.

If you edit an existing License Type, any licenses created with that type will not auto-

matically update with the new License Type settings. Use the License Update process

(LP> License Update) to update multiple licenses.

Step by Step

1     Open the License Type Selection window. 
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l The License Type Selection window (LP> Maintenance> License Type) displays

all the license types created in the application.

l The license types that are displayed in the window can be filtered by entering a spe-

cific License Type or selecting a Category and clicking the Refresh icon .

l
Highlight a license type and click the Delete icon to delete the selected license

type.

l License types that are attached to active licenses cannot be deleted.

l
Highlight a license type and click the Modify icon or click the Create icon to

open the License Type Maintenance window.

2     Create a new License Type. 

l The License Type Maintenance window displays the license type details.

3     Complete the General tab. 

l Enter a unique License Type.

l The license type can be up to 16 alphanumeric characters.

l Select a Category from the drop-down menu to associate with the license type.

l License categories include Business, Pet and Vehicle.
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l Enter a License Class or click the field label to choose one from a list.

l License classes are user defined classifications of license types.

l License classes are created and maintained on the License Class Main-

tenance window (LP> Maintenance> License Class).

l The Auto Number field is used to determine if any licenses generated from this

license type will be automatically numbered or manually numbered.

l If No is selected, the user will be required to enter a unique license number for

every license generated from this license type.

l If Yes is selected, the license number created for each license generated from

this license type will be determined by two things:

l The first part of the license number will be the prefix entered in the Auto

Number Prefix field below.

l The second part of the license number will be the next available number

with the number of digits specified on the LP Setup window (LP> Util-

ities> Setup> Auto-Numbering Digits fields).

l An example auto-numbering format for business licenses would be BL-

10-0001 (BL for Business License and 10 for 2010). In order to use this

format, you would enter "BL-10-" in the Auto Number Prefix field and "4"

in the LP Setup> Business Auto-Numbering Digits field.

l Specify a Duration for which the licenses using this license type will be active. This

field will determine the expiration date of the associated licenses.

l Select a Duration Units from the drop-down menu to determine how the value

entered in the Duration field will be calculated.

l Duration units can be Days, Weeks, Months or Years.
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l Enter a license type Description.

l This optional field can be up to 60 alphanumeric characters.

l Check the Notification toggle if form letters should be generated for the customer

attached to the license if the license is included in an LP Letters batch.

l Check the Renewable toggle if the licenses in this type are renewable. Licenses

that are not specified as renewable will be left out of any renewal letter batches.

l Check the Use in Renewals process toggle to flag any licenses associated with

this type as eligible for renewal through the LP Renewals batch process.

l Check the Auto-calculate penalty toggle if the licenses in the type should be auto-

matically charged a penalty fee if the license renewal is past due and the renewal

fee includes an attached penalty fee.

l License renewals are considered past due if the renewal receipt date falls

after the renewed license start date.

l Check the Charge Exempt toggle if licenses generated from this license type will

be issued to organizations that have been deemed exempt from the standard licens-

ing fees.

l This toggle can be used to issue supplementary licenses that must be asso-

ciated with a primary license but do not require additional fees. This toggle is

also often associated with organizations such as churches or non-profits.

l Charge exempt licenses cannot be renewed through the Renewals process. If

both the Use in Renewals process and the Charge Exempt toggles are

checked, you will receive an error message when attempting to save the

license type.

l The Status On fields are used to specify the license status at different points in the

license life cycle. These are not generally required fields, but they are required if
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you plan to apply fees to the license when the license status changes.

l Click the Status On field label to associate a status with the displayed event.

Statuses are created and maintained on the License Status Maintenance win-

dow (LP> Maintenance> License Status).

4     Complete the Fee Codes tab. 

l The Fee Codes tab lists the fees that the system will include in the calculation when

charges are generated on licenses that use the selected license type.

l
Click the Create icon to add fees to the license type.

l Fee codes are created and maintained on the Fee Code Maintenance window (LP>

Maintenance> Fee).

l Click the License Status field label to specify when the new fee will be applied to

the license. When the status attached to the license changes to the status specified

on the new fee, the fee will be applied to the license and will also display on the

Fees tab of the License Maintenance window.

l In order for a fee to be applied to the license based on a change in license

status, the Status On fields on the General tab must be completed. If a fee is

associated with a license status, but the license is not set up to change to that

status, the fee will never be applied.

l If you attach statuses to each of the fees, only those fees associated with the

current license status will be displayed on the Fees tab of the License Main-
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tenance window. If the license status changes, only those fees associated

with the new status will be displayed.

l If a fee is not associated with a license status, that fee will always be applied

when the license or application is created and will always be displayed on the

Fee tab of the License Maintenance window.

5     Complete the Approval tab. 

l The Approval tab allows you to attach approval steps to the license type. When the

selected license type is attached to a new license, the approval steps will auto-

matically populate on the new license.

l Approval types are created and maintained on the Approval Type Main-

tenance window (LP> Maintenance> Approval Type).

l
Click the Create icon drop-down menu and select Add Approval to open the

Approval Type Selection window.

l The Approval Type Selection window will display all of the approval types cre-

ated in the LP module. Select an approval type and click the Confirm icon

to return to the Approval tab.

l Each approval type attached to the license type constitutes a new approval step.

These approval steps can be set up to notify a particular user, update the license

status, apply a fee or attach an alert code to the license when the step is approved

or failed.
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l If multiple approval steps should be started at the same time, assign the same

step number to those steps.

l
Click the Create icon drop-down menu and select Add Approval Contact to add

a contact to the approval step.

l Contacts are created and maintained on the Contact Maintenance window

(LP> Maintenance> Contact Type).

l
Use the Up and Down icons to reorder the approval steps.

6     Complete the Form tab. 

l The Forms tab lists the forms commonly used with licenses that use the selected

license type. When the selected license type is attached to a new license, the spe-

cified forms will automatically attach to that new license. They will appear on the

forms tab of the license maintenance window.

l
Click the Delete icon to delete a form to remove a form from the license type.

l
Click the Create icon to add a form to the license type.

l Check the Default Print toggle to specify the selected form as a form that should be

printed when creating the license through the Cash Receipts module.

l The LP Licensing window (CR> Cash Receipts> Enter Receipts> create a

receipt> LP Licensing icon> Forms section) will display all forms attached to

the license type. Any form with the Default Print toggle checked on the
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License Type Maintenance window will automatically have the Print toggle

checked on the LP Licenses window.

7     Complete the Miscellaneous tab. 

l The Miscellaneous tab allows the user to enter miscellaneous information regard-

ing the selected license type.

l Miscellaneous field labels are created and maintained on the Miscellaneous Field

Label Maintenance window (SS> Utilities> Miscellaneous Field Labels).

8     Complete the Renewal Schedule tab. 

l The Renewal Schedule tab will display the renewal schedule set up for the license

type.

l Select a Start Date from the drop-down menu.

l This field will default to the current date.

l The Number of Years to Generate field will determine how many years will be

covered by the generated renewal schedule.

l The Duration and Duration Units fields will automatically populate with the selec-

tions made on the General tab.
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l
Click the Generate icon to generate the renewal schedule. The results will pop-

ulate in the field below.

l
Click the Save icon the save the new license type.

9     Track any changes made to the license type record. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit history.

l The Audit Trail section will provide details about any changes made to a license

type record including the date of the change, type of change made, user that made

the change, and data table that was edited.
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LP> Maintenance> Payment Priorities

Payment Priorities Maintenance

Summary

Payment priority codes determine the order in which fees are paid. Fees attached to higher

priority level will be paid in full before fees attached to lower priority levels. If there is not

enough money to pay a certain level of priority, the system will allocate the payment across

all the fees with the same priority level.

Step by Step

1     View the existing Payment Priority codes. 

l Open the Payment Priority Maintenance window (LP> Maintenance> Payment Pri-

orities).

l The left section of the window will display all of the payment priorities that have

been created in the application. Select a payment priority in the left section of the

window and the information attached to that payment priority will populate in the

Maintenance section to the right.
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l
Click the Delete icon to delete a payment priority code. You cannot delete pay-

ment priority codes that are attached to existing fees.

l
Click on the Create icon to add a new payment priority code.

2     Create a Payment Priority Code. 

l Enter a payment priority code in the Code field. This Code can be up to 10 alpha-

numeric characters. This field will not be enabled and available for editing after the

payment priority code has been saved.

l Enter a description in the Description field. The Description can be up to 60 alpha-

numeric characters.

l Enter a Priority for the code. The priority can range from 00, the highest priority, to

99, the lowest priority.

l
Click on the Save icon or hit the ENTER key to save the comment code.
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LP> Maintenance> Pet Breed

Pet Breed Maintenance

Summary

The Pet Breed Maintenance window is used to create and maintain user-defined pet breed

classifications. These classifications can then be added to pet licenses to filter the dis-

played license by pet breed.

Step by Step

1     Open the Pet Breed Maintenance window (LP> Maintenance> Pet Breed). 

l The Pet Breed Maintenance window will display all of the pet breeds created in the

system.

l Highlight a pet breed in the left section of the window and the breed details will pop-

ulate the Maintenance section to the right.

l
Highlight a pet breed and click the Delete icon or press DELETE to delete the

selected pet breed.

l
Click the Create icon or press INSERT to create a new pet breed. This will

enable the Maintenance fields to the right.
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2     Create a new Pet Breed. 

l Enter a unique Pet Breed.

l This field can be up to 10 alphanumeric characters long.

l Once you save the new pet breed, the Pet Breed field cannot be edited.

l Enter an optional Description for the new pet breed.

l This field can be up to 60 characters long.

l
Click the Save icon to save the new pet breed.
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LP> Maintenance> Query by Example

Query by Example Report

Summary

The QBE Builder reporting tool is used to create customized reports in the Licenses and

Permits module. Reports are created in the QBE Builder by selecting columns, creating

arguments to remove records (Transaction Date < 01/01/2021), selecting how the report

will group and sort, and then defining the totals that will display on the report. After the

report has been created, it can be printed out or exported into an MS Excel, MS Access or

CSV format. Reports that have been created using the QBE Builder tool can be saved and

generated at any point.

This document will cover how to create a specific example report that provides an explan-

ation of primary tables, secondary tables, arguments and totals. When creating your own

QBE reports, it is helpful to know the general structure of the database and how the inform-

ation entered into the fields on a window will be stored in the database fields and tables.

The Table/Field help feature (Help> Table/Field) is designed to be used in conjunction with

database security (SS> Security> DB Security), but it can be helpful when building QBE

Reports to help you determine where the information entered into a field on a window is

stored. This tool will not always be helpful because it will display the exact name of the

table and field where the information is stored, but QBE Builder uses simplified and more

intuitive field and table names.
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The report we will create in this example is a list report of the expiration dates for all LP

module Business licenses within a License Type labeled "Restaurant". License Types are

user-defined, so the types available in your QBE report may be different than those in this

example. Every module with a QBE reporting tool offers a different example report, so if the

report you want to create is different or more complicated than the report created in this

example, refer to the QBE examples in other modules for more help. The QBE Report fea-

ture works the same in all of the modules, but the information that is available to report on

is different from module to module.

Step by Step

1     View the QBE Reports. 

l Open the QBE Maintenance window (LP> Maintenance> Query by Example).

l The QBE Maintenance window will display all of the reports that have been created

in the LP module. Select a report in the left section of the window and the cus-

tomized report information will populate in the right section of the window just like

many of the other maintenance windows in the application.

l Highlight a report and press DELETE to delete the highlighted report.

l
Click the Create icon or press INSERT to create a new QBE report.

l
Highlight a report and click the Print icon to print an existing QBE report. The

QBE report will be generated as soon as the resources are available on the server.
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You can view the progress of the print job using the Jobs Viewer window (Jobs

Viewer icon on the main application window).

l
Highlight a report and click the Export icon drop-down and select Export Report

to export the highlighted report data.

l
Highlight a report and click the Export icon drop-down and select Export Defin-

ition to export the report definitions of the highlighted report. This exported report

definition file can then be imported using the Import icon . This allows organ-

izations to share QBE reports.

2     Select the tables that contain the information you would like to include on the report. 

l The first step in creating a customized report is selecting the information you would

like to display on the report. Information in a database is organized into tables and

fields. Fields are used to store specific information, such as customer names. Fields

are then grouped into tables. For example, a grouping could consist of a customer

table that contains all of the general customer information, such as address and

phone number. When information is entered into a window in the application, that

information is stored in a specific field within a specific table. When creating a QBE

report, select the tables that contain the information you would like to include on the

report and then select the fields.

l Select a table from the Table Name drop-down menu in the Primary Table section.

The Available Fields section will populate with the fields grouped into that table. If
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the table you select does not contain all of the fields you want to report on you will

have to select a secondary table.

l Some tables in the database are linked together because they share a common

field called a key. The key connects the data in the two tables together and defines

how the data in one table is related to the data in another table. If the table you

selected in the Table Name drop-down menu in the Primary Table section is linked

to other tables, you can select a secondary table in the Secondary Table section. As

you select a secondary table from the Table Name drop-down menu, new fields will

be added at the bottom of the Available Fields section. If you need information from

two different tables, but those tables are not linked together, you will not be able to

create the report.

l From the Table Name drop-down menu in the Primary Table section, select

License Master.

3     Select the fields you would like to include in the report. 

l After you have selected the tables you can pull the fields from those tables onto the

report. Check the toggles of the fields you would like to include on the report in the

Available Fields section. Only fields with a check will display on the report.

l In the Available Fields section, check the License Number, Expiration Date, Do

Not Renew, Doing Business As, and Business Phone toggles. These are the

columns that will show up in the report.

4     Create a filter argument for the report. 
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l The fields below the Table Name drop-down menu are used to create an argument

that will filter the information that will display on the report. These arguments are lim-

ited to 2048 characters.

l In order to filter the report to only include Business licenses that fall within the "Res-

taurant" license type, we need to create an appropriate argument.

l Select Category from the first drop-down menu directly below the Table

Name field. Selecting a value for this field activates the two fields to the right.

l The next field contains the operators that will give the argument meaning.

Select Equals from this drop-down menu.

l Type Business in the third argument field.

l Click the Add button to save the argument to the Primary Table field.

l Click the AND button to add the second part of our argument.

l The AND and OR buttons will be enabled after you add the argument to

the report. The AND and OR buttons are used to link the conditions of

an argument together so you can build more complicated filtering.

l The brackets are used to define the order in which the AND and

OR statements will be applied. Arguments within brackets will be

calculated before arguments outside of brackets. For example,

you can create an OR statement inside an AND statement using

the following format: (statement 1 OR statement 2) AND (state-

ment 3 OR statement 4). The OR statements inside the brackets

will be processed first, and then the AND statement will be

applied.
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l Select License Type from the first drop-down menu directly below the Table

Name field. Selecting a value for this field activates the two fields to the right.

l The next field contains the operators that will give the second argument mean-

ing. Select Equals from this drop-down menu.

l Type Restaurant in the third argument field. Confirm that the license type is

spelled correctly. If not, your report will not return the desired results.

l Click the Add button to save the argument to the Primary Table field.

l
Click the Test Query icon to confirm that the query is valid and will return

results.

l Enter the arguments in the Secondary Table section.

l When you enter an argument in the Primary Table and the Secondary Table

section the arguments will be joined with an AND statement, meaning records

must meet the conditions in both section before they will display on the report.

l Our example does not use a secondary table.

5     Set the number of records that will display on the report. 

l The Limit field in the Primary Table section is used to define the maximum number

of records that will display on the report. If you set this value to a very large number

(such as 10,000,000) you run the risk of creating a report that will take a long time

for your server to process.

l Enter 50 in the Limit field to limit our LP restaurant licenses report to 25 results.
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6     Modify the report layout. 

l After the fields have been selected and the arguments have been entered on the

report you are ready to set up the report layout. The report layout allows you to

define how the report will be grouped and totaled, and also allows you to select

which fields will total.

l
Click the Modify Report Layout icon to open the QBE Layout window.

l Move the columns that display in the QBE Report Layout section to change the

order in which the information will display on the report.

l Move column headings to the section above the column headings to change how

the information is grouped on the report.

l The Column Totals section is used to select which columns should be totaled on

the report. Check the toggle of the totals you would like to include on the report.

l Only columns that would provide a meaningful total will be available in the

Column Totals section.

l Our report does not use totals.

l
Click the Confirm icon when complete to save the report layout. The QBE report

will print in the saved format when the report is generated.

7     Save the report. 
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l Enter a name for the report in the Report Name field.

l
Click the Save icon when complete.

8     Print or export the report. 

l
Press ENTER or click the Print icon to generate the report.

l
Click the drop-down arrow next to the Export icon to select the export format. A

window will open allowing you to select the path where the exported file will be cre-

ated.

l If your report appears to be missing information but your filters seem to be correct,

make sure the Limit field in the Primary Table section contains a large enough num-

ber to contain all of the records you want to include in the report.
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LP> Maintenance> Queue

Queue Maintenance

Summary

Licenses and Permits module Queues are user defined groups of employees used to spe-

cify who is responsible for approving or failing an approval step on a license. Queues are

attached to Approval Type codes that are then attached to licenses on the Approval tab

(LP> Maintenance> License> Approval tab). When an approval step is approved, the mem-

bers of the queue assigned to the following approval step will be notified that the license

requires their attention.

Step by Step

1     Open the Queue Selection window (LP> Maintenance> Queue). 

l The Queue Selection window will display all of the existing Queues in the applic-

ation.

l
Click the Delete icon to remove a highlighted queue.

l You will not be able to delete a queue that is attached to an approval step on

an LP license.
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l
Highlight a queue and click the Modify icon to edit the selected queue.

l
Click the Create icon to create a new queue. This will open the Queue Main-

tenance window.

2     Create a new queue. 

l Enter a Queue name. This is the name that will be used to recognize the queue

when selecting it.

l This field can be up to 32 characters long.

l Once you save the new queue, you will not be able to modify this field.

l Enter an optional queue Description.

l The description field can be up to 128 characters long.

l The Queue Members section is used to add Springbrook users to the queue. You

must have at least one user attached to a queue.

l
Click the Create icon to add a new user to the queue. This will open a list

of users to select from. The user information will display in the window.

l To delete a user from the queue, highlight the user and click the Delete icon

.

l
Click the Save icon when complete.
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LP> Maintenance> Remit Address
Maintenance

Remit Address Maintenance

Summary

The Remit Address is the address of the organization office that is designated to receive

remittances. The remit address will appear on printed LP Adjustments and Past Dues State-

ments.

Step by Step

1     View the existing Remit Address Codes. 

l Open the Remit Address Maintenance window (LP> Maintenance> Remit

Address).

l The Remit Address Maintenance window will display all of the remit address codes

that have been created in the application.

l
Highlight a remit address code and click the Delete icon to delete the selected

remit address.
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l Edit a remit address code by highlighting the code in the left section of the window

and editing the remit address information in the Maintenance section of the window.

l Once a remit address has been saved, the remit address code cannot be

edited.

l
Click the Create icon to create a new remit address code.

2     Create a new Remit Address Code. 

l Enter a unique remit address Code.

l This required field can be up to 20 alphanumeric characters long.

l Enter an employee name in the Address Care Of if a specific employee should be

notified upon receipt. This is similar to an Attention field on a postal address.

l Complete the remaining remit address information fields.

l
Click the Save icon the save the remit address code.
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LP> Past Dues

Process Past Dues in LP

Summary

Once charges have been generated on licenses, Past Dues can be assessed and State-

ments can be generated. Follow this process to generate Past Dues in the LP module.

Step by Step

1     Create a new Past Dues batch. 

l Select the Past Dues palette in LP> Past Dues. This will expand the Past Dues

palette and display the steps in the Past Dues process.

l Select New from the Past Dues batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Past Dues process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields will default to the current fiscal

period and fiscal year. These values are used for reference only, and are not neces-

sary the fiscal month and year the transactions in the batch will be posted to. The
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fiscal period the transactions are posted to is determined by the journal Entry date

entered when creating the GL Distribution List report.

l
Type in a batch number and click the Save icon or press ENTER to create a

batch in the current batch month and year.

l To automatically create a batch with the next available batch number (the

highest batch number used in the present month plus one), click the Generate

icon .

l The batch number is used to identify a specific batch. Batch numbers are limited to

five digits and must be unique with the batch month of the batch year.

l You can have more than one open batch in a process at a time.

l If there is an open batch, the batch with the lowest batch number and fiscal period

will open. Select a batch from the drop-down menu at the top of the palette.

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate Past Dues. 

l Open the Generate Past Dues window (LP> Past Dues> Generate).

l Select the License Types you would like to include in the batch.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed License Types. All License Types are selected by

default.
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l These icons can be used to select or deselect the Categories and

Statuses as well.

l License Types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Types).

l Select the license Categories you would like to include in the batch.

l Categories are attached to licenses on the License Maintenance window (LP>

Maintenance> License> Category drop-down menu).

l Select the license Statuses you would like to include in the batch.

l License Statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l The Aging Date tells the system to ignore all transactions after the date entered in

this box.

l The Transaction Date is the transaction date that will be associated with the new

penalty charge being generated.

l The Due Date is the date that the new penalty charge being generated is due.

l The Transaction and Due dates can also be used for calculating penalties in

future Past Due batches. If an account included in the current Past Due batch

remains unpaid, the transaction or due date specified here can be used in a

future Past Due batch to calculate a new past due penalty that includes the

past due penalty generated from the current batch. This will require that the

Include previous penalties in past due amount toggle is checked and the

past due penalty fee code applied in the current batch includes an attached

late fee (LP> Maintenance> Fee> Late Fee field).

l The Minimum Age will cause the process to ignore all transactions with an age less

than the minimum age. Enter the minimum age in days.
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l The Maximum Age will cause the process to ignore all transactions with an age

greater than the maximum age. Enter the maximum age in days. If you want to

include all transactions enter 999 in the Maximum Age field.

l Click the Age From drop-down menu to specify Due Date, Post Date, or Trans-

action Date as the age from date.

l There are three rounding choices in the Round drop-down menu.

l Round Up will round all amounts up to the next increment you have specified

in the Round To field. If you round to the nearest dollar and a penalty is cal-

culated at $1.01, Round Up will make that a $2.00 penalty. A penalty cal-

culated at $1.99 will also round to $2.00.

l Round Down will round all amounts down to the previous increment you have

specified in the Round to the nearest field. With this choice, if you have spe-

cified $1.00 in the Round to the nearest field, and the penalty is calculated at

$1.99, it will round down to $1.00. Also, a penalty calculated at $1.01 will

round to $1.00.

l Select Off to round consumption up if the consumption decimal amount is 0.5

or greater and down if the decimal amount is less than 0.5.

l If your penalties use percentages to calculate you can control how the system

rounds the penalty amounts. The Round To field allows you to determine if you

want the system to round to the nearest penny, five cents and so on. If you round

penalties to the nearest dollar, put 1.00 in the Round to the nearest field.

l Check the Include previous penalties in past due amount toggle and the past

due amounts on which the penalties are calculated will include any previous pen-

alties that are past due.
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l This toggle will only affect the new past due penalty calculations if the original

penalty fee code applied to the account includes an attached late fee (LP>

Maintenance> Fee> Late Fee field).

l Check the Include uncommitted payments toggle to include payments that have

not yet been committed in the Past Dues batch.

l
When finished, click the Confirm icon .

3     Edit the past dues. 

l Open the Edit Past Dues window (LP> Past Dues> Edit).

l The Edit Past Dues window displays all of the currently generated past dues. You

may edit these charges by clicking the Expand button next to a line item and modi-

fying the amount listed in the Penalty Amount column.

l Check the Print toggle next to each of the line items you would like to include in the

batch.

l
Use the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed past due records.

l All line items will be checked by default.

l
When finished, click the Save icon to save your changes.

4     Print the Aging Report. 
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l Open the Aging Report window (LP> Past Dues> Aging).

l The Aging report displays those licenses that have outstanding past due balances.

l Not all of the print options are enabled.

l The toggles in the License Type, Category, and License Status fields are

read-only and determined by your selections on the Generate step. You can

use the Select All or Deselect All icon drop-down menus to select or

deselect all of the toggles, but you will not be able select specific toggles.

l Specify an age range in the Minimum Age and Maximum Age fields.

l The Age From drop-down menu will be inactive as this option was specified on the

Generate step.

l Select the order you would like the report to print in the Sort By drop-down menu.

l Specify a Minimum Balance to filter out transactions that fall below a particular dol-

lar value.

l Check the Include zero balance licenses toggle to include licenses that have a

zero balance in the report.

l Check the Include negative balance licenses toggle to include licenses that have

a negative balance in the report.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l The report will display the Category, Application Number, License Number, Cus-

tomer Number, Balance, and the Past Due Balance for past dues Under 30 days,

30-60 days, 60-90 days, 90-120 days, and over 120 days.

5     Print the Proof List. 

l Open the Past Dues Proof List window (LP> Past Dues> Proof List).

l Select the report type you would like to print.

l The Summary report displays the Invoice Number, Transaction Date, Trans-

action Type, Customer Name, Application Number, License Number, Descrip-

tion, Amount and Report Total.

l The Detail report includes the information displayed in the Summary report

and also displays Fee Code, Debit Account, Credit Account and Fee Amount.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You
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can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Print the GL Distribution report. 

l Open the GL Distribution Report window (LP> Past Dues> GL Distribution).

l Enter the transaction date you want to appear in the General Ledger for this batch in

the Journal Entry date field. This date will determine the fiscal period in which the

invoices are recorded.

l The Fiscal Period and Fiscal Year fields will populate based on the Journal

Entry date selected.

l Select the Report Type from the drop-down menu.

l The Summary report displays the Batch Number, Fund, Account Number,

Description, total Debit Amount by account and total Credit Amount by
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account. By default the report will subtotal by Fund and give you a grand total

of debits and credits.

l The Detail report displays everything included in the Summary report as well

as a detailed break-down of individual credits and debits for each account.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

7     Print the Past Due Statements. 

l The Past Due Statements provide the complete financial detail for the account that

is past due.

l Open the Past Due Statements window (LP> Past Due> Statements).
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l Select the Report Type from the drop-down menu.

l The Summary statement displays the Customer Name, Customer Address,

Customer Number, Statement Date, Due Date, Invoice Description, Invoice

Number, Invoice Date, invoice Due Date, Invoice Amount, Balance Due, Pen-

alty Charged, Total Due, and Total Balance Overdue.

l The Detail statement displays everything included in the Summary statement

as well as the Line Item Description, Line Item Balance Due, and Line Item

Penalty Charged.

l Use the Printer Adjustment field to adjust where the first line of the statement will

print. If you adjust the alignment you may want to print a test statement before print-

ing a large batch.

l Zero is the system default. Adjusting the value up will move the first line of the

statement up on the printed page and adjusting the value down will move the

first line down.

l Select how you want the logo to display in the Logo Options field.

l Select All Pages to display the logo on all pages of the statements.

l Select First Page Only if you would like to display the logo on the first page

of the statement only. If the statement is more than one page, the logo will not

display on the second page and the space where the logo normally prints will

be blank, shifting all fields on the second page up.

l Select Don’t Print and Leave Room if you would like to leave the space that

the logo normally prints in on the top of every page, but leave the logo off the

statements. If the statement is more than one page, the spacing on the

second page will be the same as the first. Choose this option if you are using

pre-printed statement stock with a logo at the top of every page.
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l Select Don't Print and Don't Leave Room if you would like to print the state-

ments without logos or blank spaces.

l If more than one statement is being printed, select how the statements are sorted in

the Sort By field. The statements can be sorted by Application Number, License

Number, Customer Number, Customer Name, or Zip Code.

l In the Message box, type a global message you want to print on all of the past due

statements. This message will appear at the top of the statement.

l Check the Print Perforation Line toggle to include a perforation line at the top of

the returnable section of the invoice.

l The Remit Address section will populate with the remit address specified on the

Remit Address Maintenance window (LP> Maintenance> Remit Address).

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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8     Print the Past Due Letters. This is an optional step. 

l The Past Due Letters are meant to be run in conjunction with the Past Due State-

ments. Rather than providing the financial detail found in the statements, letters

provide general information such as the total past due.

l Select a Form from the drop-down menu.

l The printed letters will use the selected Form as a template.

l Forms are created and maintained on the Forms Maintenance window (LP>

Maintenance> Forms).

l The Tran Date field will populate with the transaction date specified on the

GL Distribution step.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.

l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

9     Commit the Past Dues batch. 

l Open the Commit a Past Dues batch window (LP> Past Dues> Commit).

l The Journal Entry Date field determines which fiscal period the journal entries will

be posted to. This field will populate with the journal entry date entered when cre-

ating the GL Distribution report. If you want to change this date, you will have to

return to that step and change the JE date.
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LP> Refunds

Process Credit and Deposit Refunds

Summary

Overpayments and deposits can result in a credit balance on a customer’s account. In the

Licenses and Permits module, you can refund these credit balances through the Refunds

process.

Step by Step

1     Create an LP Refunds batch. 

l Select the Refunds palette in LP> Refunds. This will expand the Refunds palette

and display the steps in the batch process.

l Select New from the Refunds batch number drop-down menu to create a new batch.

This will open the New Batch window.

l If there are open batches in the Refunds process, you can create a new batch

without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The transaction date of the refunds is set up
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in the Generate step and the fiscal period the transactions are posted to is determ-

ined by the Journal Entry Date entered when creating the GL Distribution Report

(LP> Refunds> GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and
clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate the LP Refunds. 

l Open the Generate Refunds window (LP> Refunds> Generate).

l Select each License Type that should be included in the refunds batch.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed License Types. All License Types are selected by

default.

l These icons can be used to select or deselect the License Statuses and

Categories as well.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

PROCESS CREDIT AND DEPOSIT REFUNDS 128



l Select each License Status that should be included in the refunds batch.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l The Category field is used to specify which combination of Business, Pet and

Vehicle licenses will be included in the refunds batch.

l Select the Transaction Type that will be used for the refunds batch.

l CreditCash transactions are the only transactions that can be refunded in LP.

l Click the Age From drop-down menu to select either Transaction Date or Post

Date. This will determine which filter date you will age from.

l The Age From Date will default to today's date.

l The Minimum Age Days field is used to limit the licenses you would like to

include in the batch by age days.

l The New Tran Date will default to the current date, but can be overridden. It is the

date that will be associated with the refund adjustment to the customer’s license.

l The Minimum Amount field is used to limit the refunds included in the batch to a

minimum amount. Specifying a minimum amount can prevent licenses with only a

negligible credit from being included in the batch.

l Check the Allow refunds on licenses with outstanding balances toggle if you

would like to generate refunds for licenses that meet the filter criteria but still have

outstanding balances as well.

l If you would prefer to apply credits to outstanding balances, do not check the

toggle. You can use the adjustments process to apply credits and deposits to

outstanding balances.
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l The Licenses field is used to add individual licenses to the refunds batch.

l
Click the Create icon to add a license to the batch. This will launch the

License Selection window.

l
Highlight the desired licenses and click the Confirm icon to add them to

the batch.

l Press SHIFT or CTRL while selecting licenses in order to select multiple

licenses for refunds.

l If individual licenses are added to the refunds batch, all other filter details spe-

cified on the Generate window will be disregarded. Only the selected licenses

will be added to the batch.

l
Highlight a license and click the Delete icon to remove it from the refunds

batch.

l
Click the Confirm icon to generate the refunds batch.

3     Edit the LP Refunds. 

l Open the Edit Refunds window (LP> Refunds> Edit).

l The Refunds tab will display all of the licenses that will be included in the refunds

batch.
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l Click the Expand button next to a license to display the refund details.

l The Amount column can be edited in the event that the actual refunded

amount should be less than the generated refund amount. This amount must

be greater than zero and cannot be edited to exceed the original generated

refund amount.

l
Highlight a license and click the Delete icon to remove the license from the

refunds batch.

l The Errors tab will display all of the licenses that met the filtering requirements of

the Generate step but cannot be included in the refunds batch.

l The Warning Message column will display the reason that the license cannot

be included in the batch. Licenses that meet one of the following criteria can-

not be included in a refunds batch:

l License credit is already in an open Refunds batch.

l License credit is in an open Adjustments batch.

l License credit is in an open Renewals batch.

l
Click the Save icon if any changes were made during the edit step.

4     Print the Refunds Proof List. 
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l Open the Proof List window (LP> Refunds> Proof List).

l Select the Report Type you would like to print.

l The Summary report will display the Invoice Number, Transaction Date, Trans-

action Type, license holder's Name, Application Number, License Number,

transaction Description and transaction Amount. The report will also provide a

total amount.

l The Detail report will display everything included in the Summary report as

well as the individual Fee Code, Debit Account and Credit Account for each

refund transaction in the batch.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the Refunds GL Distribution report. 
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l Open the GL Distribution window (LP> Refunds> GL Distribution).

l Enter the transaction date you want to appear in the General Ledger for this batch in

the Journal Entry date field. This date will determine the fiscal period in which the

invoices are recorded.

l The Fiscal Period and Fiscal Year fields will populate based on the Journal

Entry date selected.

l Select the Report Type from the drop-down menu.

l The Summary report will display the Fund, Account, Description, Debit

Amount and Credit Amount for each account in the batch. The report will also

provide Fund and Report Totals.

l The Detail report will display everything included in the Summary report as

well as additional debit and credit information for the individual transactions in

the refunds batch.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the Refunds batch. 

l Open the Commit Refunds window (LP> Refunds> Commit).

l The Batch Number, Journal Entry Date, Fiscal Period and Fiscal Year fields will pop-

ulate with the details specified when the batch was created.

l The AP Settings section is used to set up how the Account Payable invoices will be

generated.

l Enter an open AP Batch number or click the field label to select an open AP

Invoices batch.

l If you would like to create a new AP Invoices batch for the refunds, click

the Generate icon . This will create a new batch using the next avail-

able batch number. The new batch number will populate the AP Batch

field.

l Update the Fiscal Year field with the up and down arrows if desired.

l
Click the Confirm icon to commit the refunds batch.

l Once the batch is committed, the refund invoices will be sent to the AP Invoices pro-

cess.
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LP> Renewals

Generate and Edit LP Renewals

Summary

The LP Renewals process is used to generate Renewal letters and the associated renewal

invoices for a filtered group of LP Licenses. In order for a license to be eligible for the Rene-

wals process, it must be attached to a license type with the Use in Renewals process

toggle checked (LP> Maintenance> License Type> General tab> Use in Renewals process

toggle).

Step by Step

1     Create an LP Renewals batch. 

l Select the Renewals palette in LP> Renewals. This will expand the Renewals

palette and display the steps in the batch process.

l Select New from the Renewals batch number drop-down menu to create a new

batch. This will open the New Batch window.

l If there are open batches in the Renewals process, you can create a new

batch without affecting the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current calendar

period and are used for reference only. The transaction date of the renewal is set up

in the Generate step and the fiscal period the transactions are posted to is determ-

ined by the Journal Entry Date entered when creating the GL Distribution Report

(LP> Renewals> GL Distribution).

l
Click the Generate icon to populate the Batch Number field with the next avail-

able batch number. Batch numbers are limited to five digits and must be unique

within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number and
clicking the Save icon .

l You can delete batches by selecting a batch and pressing DELETE.

2     Generate the LP Renewals. 

l Open the Generate Renewals window (LP> Renewals> Generate).

l Select each License Type that should be included in the renewals batch.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed License Types. All License Types are selected by

default.

l These icons can be used to select or deselect the License Statuses and

Categories as well.
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l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l Only those license types with the Use in renewals process toggle

checked will be displayed.

l Select each License Status that should be included in the renewals batch.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l The Category field is used to specify which combination of Business, Pet and

Vehicle licenses will be included in the renewals batch.

l Enter a New Transaction Date and a New Due Date for the renewals batch.

l The New Transaction Description field is used to enter a description for the

renewal transaction.

l While the total character limit on this field is 512 alphanumeric characters,

only the first 40 characters will display on the renewals proof list.

l Enter a New License Status or click the field label to select one from a list. This is

the status that the License will change to when the renewals batch is committed.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Check the Apply available credits toggle in order to apply any available credits on

an included license towards the outstanding balance on that license after it is

renewed.

l The applied credit will be displayed on the Edit window.

l The Filter tab is used to filter the licenses included in the renewals batch by issue,

start and expiration date.
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l Specify the desired dates to the filter the included licenses.

l The License tab is used to add individual licenses to the renewals batch.

l
Click the Create icon to add a license to the batch. This will launch the

License Selection window.

l
Highlight the desired licenses and click the Confirm icon to add them to

the batch.

l Press SHIFT or CTRL while selecting licenses in order to select multiple

licenses for renewal.

l If individual licenses are added to the renewals batch, all other filter details

specified on the Generate window will be disregarded. Only the selected

licenses will be renewed.

l
Highlight a license and click the Delete icon to remove it from the renew-

als batch.

l
Click the Confirm icon to generate the renewals batch.

3     Edit the LP Renewals. 

l Open the Edit Renewals window (LP> Renewals> Edit).

l The Renewals tab will display all of the licenses that will be included in the renewals

batch.
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l
Highlight a license and click the Delete icon to remove the license from

the renewals batch.

l The Errors tab will display all of the licenses that met the filtering requirements of

the Generate step but cannot be included in the renewals batch.

l The Warning Message column will display the reason that the license cannot

be included in the batch. Licenses that meet one of the following criteria can-

not be included in a renewals batch:

l License is set up as non-renewable.

l License is already in an open renewals batch.

l License is in an open Cash Receipts batch.

l License is in a pending web transaction.

l License does not have any attached fees that either match the status of

the license or have no defined status.

l License is set up as Charge Exempt.

l
Click the Save icon if any changes were made during the edit step.

4     Commit the Renewals batch. 
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LP> Renewals

Commit LP Renewals

Summary

Once the LP Renewals have been generated and edited, the batch can be committed. Fol-

low these steps to complete the renewals process.

Step by Step

1     Print the Renewals Proof List. 

l Open the Proof List window (LP> Renewals> Proof List).

l Select the Report Type you would like to print.

l The Summary report will display the Invoice Number, Transaction Date, Trans-

action Type, doing business as Name, Application Number, License Number,

renewal transaction Description and Amount for each license in the batch. A

report total will also be provided.

l The Detail report will display everything included in the Summary report as

well as the Fee Code, Debit Account and Credit account for each transaction

in the batch.
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

2     Print the Renewals GL Distribution report. 

l Open the GL Distribution window (LP> Renewals> GL Distribution).

l Enter the transaction date you want to appear in the General Ledger for this batch in

the Journal Entry date field. This date will determine the fiscal period in which the

invoices are recorded.

l The Fiscal Period and Fiscal Year fields will populate based on the Journal

Entry date selected.
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l Select the Report Type from the drop-down menu.

l The Summary report will display the Fund, Account, Description, Debit

Amount and Credit Amount for each account in the batch. The report will also

provide Fund and Report Totals.

l The Detail report will display everything included in the Summary report as

well as additional debit and credit information for the individual transactions in

the renewals batch.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

3     Generate the Renewal Letters. 
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l Open the Renewal Letters window (LP> Renewals> Letters).

l Select the desired Form from the drop-down menu.

l If the drop-down menu does not display any forms, you will need to create an

LP-specific form before proceeding. Forms are created and maintained on the

Forms Maintenance window (LP> Maintenance> Forms).

l Specify a Transaction Date for the letters. This field will automatically populate

with the current date.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.

l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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l The format and information included in the renewal letters is determined by the form

selected.

4     Commit the Renewals batch. 

l Open the Commit Renewals window (LP> Renewals> Commit).

l The Batch Number, Journal Entry Date, Fiscal Period and Fiscal Year fields will pop-

ulate with the details specified when the batch was created.

l
Click the Confirm icon to commit the Renewals batch.

l Once the batch is committed, the license status on all of the licenses included in the

batch will be updated to the status specified on the Generate step.

l A new Renewals invoice line item will now be displayed on the History tab of the

License Maintenance window.
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LP> Reports> Aging Report

Aging Report

Summary

The aging report displays those accounts that have past due, outstanding balances.

Step by Step

1     Open the Print Aging Report window (LP> Reports> Aging Report).

2     Configure the report. 

l Check the toggle next to each License Type you would like to include in the report.

All license types will be checked by default.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l Check the toggle next to each Category you would like to include in the report. All

categories will be checked by default.

l Check the toggle next to each License Status you would like to include in the

report. All license statuses will be checked by default.
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l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Enter the aging date in the Aging Date field. This is the date used to calculate the

age of the transactions filtered into the report and will determine which aging

column (0 to 30, 31 to 60, 61 to 90, etc.) each transaction will be placed in.

l Enter a Minimum and Maximum Age for the licenses and applications you would

like to include in the report.

l Click the Age From drop-down menu and select Due Date, Post Date, or Trans-

action Date to designate from which date the aging process will begin.

l Click the Sort By drop-down menu and select Application Number, Customer

Name, Customer Number, License Number, or License Type to designate how the

report is sorted.

l Enter a Minimum Balance to limit the displayed accounts by account balance.

l Check the Include Zero Balance Accounts toggle to include accounts that have a

zero balance.

l Check the Include Negative Balance Accounts to include accounts that have a

credit balance.

l Check the Include previous penalties in past due amount to include any pre-

vious penalty balances in the current balance.

l Check the Include Uncommitted Payments toggle to include uncom-

mitted/pending payments when calculating the balances on invoices to be included

on the Aging Report.

l The report will display the User that created the report, Date Printed, Aging Date,

Category, Application Number, License Number, License Type, Customer Number,

and Customer Last Name. The report will also provide a total Balance by license or
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application, balance for Under 30 days, 30-60 Days, 60-90 Days, 90-120 Days, and

Over 120 Days as well as a report total.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Reports> Business License Listing

Business License Listing Report

Summary

The Business License Listing report displays a filtered range of business license details.

Step by Step

1     Open the Business License Listing window (LP> Reports> Business License List-

ing).

2     Configure the report. 

l Check the toggle next to each License Type you would like to include in the report.

l
By default, all license types will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed license types.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).
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l Check the toggle next to each License Status you would like to include in the

report.

l By default, all license statuses will be selected.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Check the toggle next to each Business Type you would like to include in the

report.

l This field will only be enabled if Business is selected from the Category drop-

down menu on the License tab. If Business is selected, all business types will

be selected by default.

l Business types are created and maintained on the Business Type Main-

tenance window (LP> Maintenance> Business Type).

l Use the Sort By drop-down menu to specify how the report will be sorted.

l Use the License, Filters, and Date tabs to filter the included licenses by the fields

displayed on those tabs.

l Select Yes in the Show renewal history drop-down menu to include the busi-

ness license renewal history in the report. You can then use the Number of

Renewals field to specify how many previous licenses are displayed.

l The report will include the Application Number, Business Name, Business Number,

Customer Number, License Number, License Type, License Status, Lot Number,

Tax Lot, Address, Application Date, Issue Date, Start Date and Expiration Date. If

the renewal history is included, the Transaction Date, Issue Date, Start Date and

Expiration Date of previous licenses will also be displayed.

3     Print the report. 
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

BUSINESS LICENSE LISTING REPORT 150



LP> Reports> GL Trial Balance

GL Trial Balance Report

Summary

The GL Trial Balance report displays the change in account balance of a specified cus-

tomer during a specified period of time.

Step by Step

1     Open the GL Trial Balance Report window (LP> Reports> GL Trial Balance).

2     Configure the report. 

l Enter a date range in the JE Date From and JE Date To fields.

l Select a Report Type from the drop-down menu.

l The Brief report will display the GL Account number, Description, Beginning

Balance, Debit Amount, Credit Amount, and Ending Balance.

l The Summary report will display everything included in the Brief report as well

as the Journal Entry Date, Application Number, License Number, Transaction

Date, Transaction Type, and Transaction ID.
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l The Detail report will display everything included in the Summary report as

well as the Fee Code and Fee Type.

l Enter a GL Account for the report or click the field label to select one from a list.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Reports> License Listing

License Listing Report

Summary

The License Listing report displays a filtered range of license details.

Step by Step

1     Open the Print License Listing window (LP> Reports> License Listing).

2     Configure the report. 

l Check the toggle next to each License Type you would like to include in the report.

l
By default, all license types will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed license types.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).
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l Check the toggle next to each License Class you would like to include in the report.

l By default, all license classes will be selected.

l License classes are created and maintained on the License Class Main-

tenance window (LP> Maintenance> License Class).

l Check the toggle next to each License Status you would like to include in the

report.

l By default, all license statuses will be selected.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Check the toggle next to each Business Type you would like to include in the

report.

l This field will only be enabled if Business is selected from the Category drop-

down menu on the License tab. If Business is selected, all business types will

be selected by default.

l Business types are created and maintained on the Business Type Main-

tenance window (LP> Maintenance> Business Type).

l Check the toggle next to each Business Class you would like to include in the

report.

l This field will only be enabled if Business is selected from the Category drop-

down menu on the License tab. If Business is selected, all business classes

will be selected by default.

l Business classes are created and maintained on the Business Class Main-

tenance window (LP> Maintenance> Business Class).
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l Specify how the report will be displayed on the Layout tab.

l The First Sort drop-down menu is used to select a primary sort value for the

report.

l The Second Sort drop-down menu will determine how the licenses are sorted

within the First Sort option.

l The Third Sort drop-down menu will determine how the licenses are sorted

within the Second Sort option.

l The Address drop-down menu is used to specify which address attached to

the license will be displayed on the report.

l Use the License, Customer, and Date tabs to filter the included licenses by the

fields displayed on those tabs.

l The top of the report will display the filter values specified on the License, Cus-

tomer, and Date tabs. The report will include the Category, Application Number,

License Number, License Type, License Class, Business Number, Customer Num-

ber, Customer Name, Customer Address, Pet Tag Number, Vehicle Sticker Num-

ber, Tax Lot, Lot Number, License Status, and Balance.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Reports> Pet License Listing

Pet License Listing Report

Summary

The Pet License Listing report displays a filtered range of pet license details.

Step by Step

1     Open the Pet License Listing window (LP> Reports> Pet License Listing).

2     Configure the report. 

l Check the toggle next to each License Type you would like to include in the report.

l
By default, all license types will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed license types.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).
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l Check the toggle next to each License Class you would like to include in the report.

l By default, all license classes will be selected.

l License classes are created and maintained on the License Class Main-

tenance window (LP> Maintenance> License Class).

l Check the toggle next to each License Status you would like to include in the

report.

l By default, all license statuses will be selected.

l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Specify how the report will be displayed on the Layout tab.

l The First Sort drop-down menu is used to select a primary sort value for the

report.

l The Second Sort drop-down menu will determine how the licenses are sorted

within the First Sort option.

l The First Misc Field and Second Misc Field drop-down menus are used to

specify which miscellaneous fields are included in the report.

l If miscellaneous fields are selected from these drop-down menus, the

report will include the user-defined label of the miscellaneous field as

an additional column heading. The values in these fields will be dis-

played below.

l Use the License, Customer, and Date tabs to filter the included licenses by the

fields displayed on those tabs.

l The report will include the Application Number, License Number, Pet Tag Number,

Status, License Type, License Class, Customer Number, Customer Name,
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Customer Address, Home Phone, Pet Name, Pet Breed, Pet Color, Pet Gender and

any included miscellaneous fields.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Reports> Refunds

Refunds Report

Summary

Follow this process to print the LP Refunds Report.

Step by Step

1     Open the Refunds Report window (LP> Reports> Refunds).

2     Configure the report. 

l Check the toggle next to each License Type you would like to include in the report.

All license types will be checked by default.

l License types are created and maintained on the License Type Maintenance

window (LP> Maintenance> License Type).

l Check the toggle next to each Category you would like to include in the report. All

categories will be checked by default.

l Check the toggle next to each License Status you would like to include in the

report. All license statuses will be checked by default.
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l License statuses are created and maintained on the License Status Main-

tenance window (LP> Maintenance> License Status).

l Select a Tran Date from the drop-down menu.

l Enter a Minimum Tran Balance to limit the displayed accounts by account bal-

ance.

l The report will display the Category, Application Number, License Number, Cus-

tomer Number, License Status, Balance, Invoice Number, Transaction Type, and

Transaction Date. The report will also provide a Total Refunds amount. Check the

Print Contact Information toggle to include the Customer Name, Mailing Address,

and customer Phone Number on the report.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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LP> Utilities> Setup

Set up the Licenses and Permits Module

Summary

Follow this process to set up the LP module.

Step by Step

1     Open the License and Permits Setup window (LP> Utilities> Setup).

2     Set up the LP module. 

l Specify how the Business, Pet and Vehicle licenses will be numbered.

l Specify the Auto-Numbering Digits for the licenses.

l The software will find the largest license number with the same number

of digits in the database and begin numbering from there.

l You can have the system start auto numbering from a desired point if

you create a license number higher than all the other licenses with auto
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numbering turned off, then turn auto numbering on to create the rest of

your licenses.

l These values must be between four and seven.

l Check the Auto attach lots on licenses toggle if you would like a lot to be auto-

matically attached to a license when a customer is attached to a license.

l If a customer is attached to a permit, and that customer is the owner of a lot,

the lot will automatically be attached to the license if this toggle is checked.

l
Click the Save icon the complete the set up process.

3     Track any changes made to the LP Setup window. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit trail.

l The Audit Trail History section will provide details about any changes made to the

setup window including the date of the change, type of change made, user that

made the change, and data table that was edited.
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LP> Utilities> Change License Type

Change License Types

Summary

The Change License Type tool is used to update individual applications or licenses with a

new license type.

Step by Step

l Open the Change License Type window (LP> Utilities> Change License Type).

l Select the Category of license you would like to update.

l The category selected will determine which applications or licenses can be selected

below.

l Enter an Application Number or click the field label to select one from a list.

l Enter a License Number or click the field label to select one from a list.

l The Current License Type field will automatically populate with the license type currently

attached to the selected application or license.

l Enter a New License Type or click the field label to select one from a list.

l License types are created and maintained on the License Type Maintenance window

(LP> Maintenance> License Type).

CHANGE LICENSE TYPES 165



l Any fees, forms and approval codes associated with the selected license type will now

be associated with the application or license selected above.

l
Click the Save icon to update the selected application or license with the new license

type.
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LP> Utilities> Generate Web Keys

Generate Web Keys
Summary

The Generate Web Keys tool is used to generate web keys for license holders. These web

keys are then used by those license holders to access the Business Licensing and Licens-

ing and Tax online applications.

Step by Step

l Open the Generate Web Keys window (LP> Utilities> Generate Web Keys).

l The Selection Criteria section is used to filter the licenses that will be included in the gen-

erate tool by license type and license status.

l If web keys are generated without specifying a license type or license status, the tool

will generate web keys for all existing licenses that are not already assigned a web key.

l Enter a License Type or click the field label to select one from a list.

l License types are license templates used to quickly create similar licenses on the

License Maintenance window (LP> Maintenance> License> General tab> License

Type field).

l License types are created and maintained on the License Type Maintenance window

(LP> Maintenance> License Type).
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l If a license type is not selected, the tool will generate web keys for all eligible licenses

that are assigned the license status specified to the right.

l Enter a License Status or click the field label to select one from a list.

l License statuses are user-defined status codes that are used to define the current

status of a license. Licenses are assigned a license status on the License Maintenance

window (LP> Maintenance> License> General tab> License Status field).

l License statuses are created and maintained on the License Status Maintenance win-

dow (LP> Maintenance> License Status).

l If a license status is not selected, the tool will generate web keys for all eligible licenses

that are associated with the license type specified to the left.

l
Click the Generate icon to generate web keys for all of the licenses associated with the

license type and license status selected.

l The eligible licenses will populate the Licenses data grid below and each license will

be assigned a random web key.

l
Click the Save icon to save the web keys to the license records.
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